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CHAPTER 1: ADMINISTRATION (SYSTEM) FORM

The Administration (System) master tab and its pages contain setup data related to the 
Oracle Daybreak’s overall functionality and performance. This data affects the mechanics 
of the system: how Oracle Daybreak processes work and where it looks for files when 
completing tasks.

The Administration form’s System master tab contains the following tabs:

• Parameters
• Lookups
• User Defined Tables
• Audit Tables
• Txn Codes
• Data Files
• Error Messages
• Translation

All System tabs allow you to control the behavior of the system from a technical perspec-
tive; for example, determine values in List of Values dialog boxes, define what informa-
tion is audited, and record default values. i-flex solutions provides default values on all 
these pages.
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Parameters tab
System parameters define information or values used throughout Oracle Daybreak. They 
act as switches that control the manner in which a function is implemented, or whether or 
not Oracle Daybreak performs a particular task. Parameters are used throughout Oracle 
Daybreak to control everything from user access to what information is stored on any 
given form. Parameters also define configuration data, such as the location of Oracle Day-
break system files, the URLs for the report and image servers, and other administration 
controlled data. Some of the system parameters are setup when Oracle Daybreak is 
installed, but the values associated with the parameters will need to be reviewed and main-
tained. 

There are three types of parameters in Oracle Daybreak, divided what part of the Oracle 
Daybreak system they affect:

Type of paramter: Paramter range:

System parameters These parameters apply to the entire system.
Examples: batch processes, archiving, aging, and 
so on.

Organization parameters These parameters apply to the organization, divi-
sion, and user responsibility.
Examples: User login control, password expira-
tion.

Company parameters These parameters apply to the company and 
branch.
Examples: decision fax control, scoring model 
and so on.

As a result, the Parameters tab contains the following three pages:

• System page
• Organization page
• Company page

Many parameter values are restricted based on a system lookup (see the Lookups page 
section in this chapter for more information). Please refer to the Excel file 
Appendix_Lookups for the definition and function of individual parameters.
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Parameters tab (System page)
The System page displays and records each system wide parameter, along with its current 
value and whether or not it is enabled. These parameters relate to the overall processing of 
the system, such as Oracle Daybreak server file locations and data purging configuration.

CAUTION: These parameters can be defined only once. Changing the values of any of 
these parameters affects all related Oracle Daybreak processing. 

To set up the System page

1 On the Setup menu, choose Administration > System.

2 Choose the Parameters tab, then choose the System sub tab.

3 In the System Parameters block, enter the following information:

In this field: Do this:

Parameter* Select the system parameter (required).
Description* View the system parameter description (display only).

*Note: You can search for a particular system parameter 
using both or either of these fields and the Enter-Query 
mode.

Parameter Value Enter the value for the system parameter (required).
Enabled Select to enable the parameter.

4 Save your entry.
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Parameters tab (Organization page)
The parameters on the Organization page control Oracle Daybreak functions related to 
user log in, such as passwords and expiration dates, responsibility levels and the ability to 
access Oracle Daybreak features. Individual parameters can be created with different val-
ues for uniquely defined organizations, divisions, and responsibility combinations. 

When determining which parameter to use, Oracle Daybreak selects the best match based 
on a hierarchical sort by the Organization, Division, and Responsibility fields, with values 
of ALL being a lower order match than an exact match.

Example
Assume the organization parameter UIX_APP_VIEW_ALL_APPS (VIEW ALL APPLICA-
TIONS) has been defined as follows:

Oracle Daybreak uses these two parameters to determine which users have the ability to 
view all applications:

• If a SSC user with a responsibility of SUPERUSER was using the Lending menu’s 
Underwriting form, the system will return with a value N, and Oracle Daybreak will 
not allow the user to view all applications

• If a DSC user (one within an organization defined as ALL) with a responsibility of 
SUPERUSER, was using the Lending menu’s Underwriting form, the system will 
return with a value Y, and Oracle Daybreak will allow the user to view all applications.

Note: Be aware that while Oracle Daybreak allows for Organization parameters to be 
defined at all three hierarchical (organization, division, and responsibility) levels, not all 
will be applicable to each parameter. For example, while you can define the 
UIX_SMTP_SERVER (EMAIL SERVER FOR USER) for a responsibility, you would nor-
mally only want to define this parameter based on organization or a division.
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To set up the Organization page

1 On the Setup menu, choose Administration > System.

2 Choose the Parameters tab, then choose the Organization sub tab.

3 In the Organization Parameters block, enter the following information:

In this field: Do this:

Parameter* Select the system parameter (required).
Description* View system parameter description (display only).

*Note: You can search for a particular organization 
parameter using both or either of these fields and the 
Enter-Query mode.

Parameter Value Enter the value for the system parameter (required).
Org Select the organization for which the parameter will be 

valid (required).
Div Select the department for which the parameter will be 

valid (required).
Responsibility Select the responsibility for which the parameter will be 

valid (required).

IMPORTANT: In selecting which organization parameter 
to use, Oracle Daybreak searches for a best match using 
the following attributes:

1 Organization
2 Division
3 Responsibility

For this reason, i-flex solutions recommends creating one 
version of each organization parameter where ALL is 
these fields.

Enabled Select to enable the parameter.

4 Save your entry.
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Parameters tab (Company page)
The parameters on the Company page control Oracle Daybreak processes associated with 
functions that may vary for different companies or branches. These parameters address 
credit scoring, credit bureau interfaces, fax services, and fax generation. Individual param-
eters may be set up with different values for uniquely defined company and branch combi-
nations. 

When these parameters values are requested by the system, Oracle Daybreak responds 
with the “best” match based on a hierarchical sort ordered on company and branch fields, 
with values of ALL being a lower order match than an exact match.

Example
Assume the company parameter UIX_RUN_AAI_ACT (ONLINE ACCOUNT CREATION 
AND ACTIVATION) has been defined as:

Oracle Daybreak uses these two parameters to determine whether to create and activate an 
account online.

• When processing items for the company SSFC, Oracle Daybreak will return a value N 
and not create and activate an account online.

• When processing items for the company DCC, a company within the value ALL, Ora-
cle Daybreak will return with a value Y and create and activate an account online.
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To set up the Company page

1 On the Setup menu, choose Administration > System.

2 Choose the Parameters tab, then choose the Company sub tab.

3 In the Company Parameters block, enter the following information:

In this field: Do this:

Parameter* Select the system parameter (required).
Description* View the system parameter description (display only).

*Note: You can search for a particular company parame-
ter using both or either of these fields and the Enter-
Query mode.

Parameter Value Enter the value for the system parameter (required).
Company Select the portfolio company for which the parameter 

will be valid (required).
Branch Select the portfolio branch for which the parameter will 

be valid (required). 

IMPORTANT: In selecting which company parameter to 
use, Oracle Daybreak searches for a best match using the 
following attributes:

1 Company
2 Branch

For this reason, i-flex solutions recommends creating one 
version of each company parameter where ALL is the 
value in these fields.

Enabled Select to enable the parameter.

4 Save your entry.
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Lookups tab (Lookups page)
The Lookups page defines the contents in many of the Lists of Values (LOV) dialog boxes 
used throughout Oracle Daybreak. Fields that make use of a List of Values will only 
accept entries that are stored on this page. 

Note: Data-related List of Value dialog boxes (for example, LOVs containing account 
numbers or vendor numbers) do not use the Lookups page. If a field has a LOV with a 
lookup file attached to it, Oracle Daybreak displays the file name in a yellow hint box 
when you position the mouse cursor over the field. In the example below, the lookup file 
for the Class field is APL_CUS_CLASS_TYPE_CD.

Please refer to the Excel file Appendix_lookup for the definition and function of individ-
ual lookup types. 

The Lookups page contains two blocks: Lookup Types and Lookup Codes. Lookup 
types and codes can be system-defined or user-defined. The lookup types describe the 
function of the related lookup codes. 

For system-defined lookup types, only the Description field may be changed.
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A system-defined lookup type (Lookup Type block, System Defined Yes) is one that is 
critical to Oracle Daybreak and can not be changed. However, you can still modify the 
lookup type description and the lookup code description on the Lookups page.

A user-defined lookup type (Lookup Type block, System Defined No) is one that can be 
modified, depending on a user's business needs. You cannot modify the lookup type, 
lookup code, and system indicator. If a lookup type is user-defined, the lookup code 
belonging to that lookup type can either be system-defined or user-defined. 

A system-defined lookup code (Lookup Code block, System Defined Yes) is one on 
which Oracle Daybreak processing is dependent. Without this lookup code, the process 
produces incorrect results or fails. 

A user-defined lookup code (Lookup Code block, System Defined No) is one that can be 
defined or altered by a user.

WARNING: System-defined lookup types are required by Oracle Daybreak. The related 
lookup codes will also be system defined. If you update and save a system-defined lookup 
type as a user-defined-lookup type (that is, change the System Defined button from Yes to 
a No in the Lookup Type block), Oracle Daybreak will not allow you to change the lookup 
type back to system-defined in the future.

Note: Lookup codes cannot be deleted, as they may have been used in the past, and the 
display and processing of that data is still dependent on the existing setup.

Typically, the Oracle Daybreak Administrator would modify the descriptions of lookup 
codes and add new lookup codes to the existing lookup types as needed.
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To set up the Lookups page

1 On the Setup menu, choose Administration > System.

2 Choose the Lookups tab.

3 In the Lookup Types block, enter the following information:

In this field: Do this:

Lookup Type Enter the lookup type (required).
Description Enter the description for the lookup type (required).
System Defined? Yes No Select “Yes” if the lookup type is system defined.
Enabled Select to enable the lookup type.

4 In the Lookup Code block, enter the individual values that a field or process using the 
related lookup type may have.

In this field: Do this:

Lookup Code Enter the lookup code. These are solely dependent on the 
function of the Lookup Type (required).

Description Enter the lookup code description. This may be changed 
as required by your business (required).

Sort Enter the sort order for the lookup code. This determines 
the order these lookup codes are displayed or processed. 
(required).

Sub Code Enter the sub code for the lookup code (optional).
System Defined? Yes No If Yes is selected, the lookup type is system defined. Sys-

tem defined lookup codes cannot be modified, other than 
to change the Description or Sort fields. If No is selected, 
the lookup type is not system defined and the code can be 
be modified.

Enabled Select to enable the lookup code.

5 Save your entry.
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User Defined Tables tab (User Defined Tables page)
The User Defined Tables page allows you to maintain user-defined tables, such as the data 
attributes Oracle Daybreak uses on its Search pages. 

To set up a user-defined table, you must:

1. Define the fields on the table.

2. Join the related tables.

3. Assign the table a lookup type. 
You can create tables for different product, funding, and collateral types.
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After the creating the user-defined tables, Oracle Daybreak sorts the attributes to make 
using the system easier. These details are used with different functions of Oracle Day-
break, including:

• Searching of accounts
• Tracking of follow-up items
• Creating details in bankruptcy, foreclosure/repossession, and deficiency.

Note: Many of these tables, (ASSET TRACKING ATTRIBUTES for example) may be con-
figured during the initial setup of the application to provide for your specific business 
needs. Others, such as APPLICATION SEARCH, may be changed whenever your business 
needs change. Still others should not be changed without consulting i-flex solutions, as 
changing them would require changes to existing code for the expected results to be 
implemented. As a rule of thumb, it’s better to add or disable information on the User 
Defined Tables page than to edit existing entries.

Please refer to the Excel file Appendix_Flex_Attributes for the definition and function of 
individual user-defined tables.

To set up the User Defined Tables page

1 On the Setup menu, choose Administration > System.

2 Choose the User Defined Tables tab.

3 In the User Defined Tables block, enter the following information:

In this field: Do this:

Table Enter the user-defined table name (required).
User table Type Select the user-defined table type. This determines where 

and how the related data is being used (required).
Description Enter the description for user-defined table (required).
View Name Enter the view name. (Consult your implementation 

coordinator as to use) (required).
Product Type Select the product for the user-defined table (required).
SQL Statement Enter the SQL version of the statement (required).
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Funding Type Select the funding type associated with the user-defined 
table (required).

Collateral Type Select the collateral type associated with the user-defined 
table (required).

Sort Enter the sort order for the user-defined table relative to 
other tables of the same type (required).

System Defined? Yes No If Yes is selected, the entry is system defined. System 
defined entries cannot be modified. If No is selected, the 
entry is not system defined and it can be modified.

Enabled Select to enable the user-defined table (optional).

4 In the User Defined Table Attributes block, enter the following information:

In this field: Do this:

Attribute Enter the user-defined table attribute (required).
Description Enter the description for the user-defined table attribute 

(required).
Sub Attribute Enter the sub-attribute for the attribute (sub attributes are 

used to associate related attributes) (optional).
Data Type Select the data type for the attribute (CHARACTER, 

NUMBER, or DATE) (required).
Length Enter the maximum length of the user-defined table 

attribute (required).
LOV Type Select the list of value (LOV) type for the user-defined 

table attribute (optional).
LOV Validation Ind Select to enable LOV validation of the user-defined table 

attribute (This indicates whether the data must come 
from the LOV) (optional).

Lookup Type Enter the lookup type of the LOV associated with the 
user-defined table attribute (optional).

Sort Enter the sort order of the user-defined table attribute. If 
the sort order is changed it will only affect new instances 
of the User Defined Table, and will not affect existing 
data (required).

System Defined? Yes No If Yes is selected, the entry is system defined. System 
defined entries cannot be modified. If No is selected, the 
entry is not system defined and it can be modified.

Enabled Select to enable the user-defined table attribute so the 
attribute will be considered when creating new instances 
of the User Defined Table (optional).

Default Value Enter the default value for the user-defined table attribute 
(optional).

Operator Select the operator for the user-defined table attribute 
(required).
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Audit Tables tab (Audits page)
Oracle Daybreak allows you to track changes in the database during lease origination on 
the Underwriting and Funding forms. This includes the tracking of:

• Account status history
• Audit history of specified fields.

The Audit Tables tab (Audit page) records the tables and columns requiring an audit. Ora-
cle Daybreak stores the following details for the fields you want to audit for changes:

• Current value in field
• New value field 
• Oracle Daybreak user who changed the field’s content
• Date and time the change was made

Based on the Audits page setup, the changes can be tracked on the Verification (9) master 
tab’s Audits page on the Underwriting and Funding form.

Oracle Daybreak automatically generates scripts when you choose Generate on the Audit 
Tables tab (Audit page). This needs to be done only once at the time of setup. Once you 
determine which tables and columns to audit, choosing Generate creates database triggers, 
which when applied to the database will capture the data. The data is available on the lease 
origination forms.

To set up the Audit Table page

1 On the Setup menu, choose Administration > System.

2 Choose the Audit Tables tab.
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3 In the Audit Tables block, select the auditable table from the following information:

In this field: Do this:

Table View the table name on which audit trigger needs to be 
created (Oracle Daybreak table being audited) (display 
only).

Description Enter the table description (required).
Primary Key 1 View the table primary key column 1 (These columns 

define how to access the data in the table) (display only).
Primary Key 2 View the table primary key column 2 (display only).
Primary Key 3 View the table primary key column 3 (display only).
Primary Key 4 View the table primary key column 4 (display only).
Display Description Enter the column description to be displayed on audit 

screen (required).
Display Column Enter the table column to be displayed on audit screen 

(required).
Enabled Select to enabled the audit table so it will be considered 

when generating the database triggers.

4 In the Audit Columns block, select the auditable column from the following information:

In this field: Do this:

Column Enter the column name on which audit needs to be cre-
ated (Column in the table being audited) (required).

Description Enter the column description (description of the data con-
tained in the column) (required).

Data Type View the data type for the attribute (display only).
Enabled Select to enable the audit column.

5 Choose Generate to create auditing trigger scripts.

6 Save your entry.
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Txn Codes tab (Txn Codes page)
Oracle Daybreak uses transaction codes to define the actions and tasks it can perform; for 
example, activating an account, changing a due date, applying a late fee, and charging off 
an account. The Txn (Transaction) Codes page catalogs and defines these core Oracle 
Daybreak actions. 

Oracle Daybreak organizes transaction codes in “super groups.” All transaction codes 
within a particular super group are processed in a similar manner. The transaction super 
groups in Oracle Daybreak are as follows:

Super Group Type: Description:
TXN ACCOUNT MONETARY TXN

These transactions codes affect the monetary value of 
accounts in Oracle Daybreak; for example, activating 
accrual of interest, the assessment of fees, and closing the 
account.

TNM ACCOUNT NON MONETARY TXN
These transaction codes do not have a direct affect on the 
monetary value of the account, but are used in maintain-
ing account information. This includes changing a cus-
tomer’s driver’s license, or adding information for 
automated clearing house (ACH).

TAM AMORTIZATION TXN 
These transaction codes affect the amortized balances of 
the accounts in Oracle Daybreak.

ITM ITEMIZATION TXN
These transaction codes affect the itemization of 
accounts within Oracle Daybreak.

MEN MENU ITEM
These transaction codes control a user’s access to Oracle 
Daybreak menus, forms, and first level tabs.

TCN ACCOUNT CONDITION TXN 
These transaction codes control a user’s ability to open 
and close account conditions.

SEC SECURITIZATION TXN 
These transaction codes affect the pools of securitized 
loans or accounts within a pool of securitized loans.

COR CORRESPONDENCES 
These transaction codes relate to Oracle Daybreak corre-
spondences.

LUL SETUP LOCK/UNLOCK 
These transaction codes limit a user’s ability to change 
the existing setup data, even if they are allowed access to 
the form, by restricting access to the Lock/Unlock 
Record icon on the Oracle Daybreak tool bar.
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TEM ESCROW MONETARY TRANSACTIONS 
These transaction codes affect the monetary value of 
escrow accounts in Oracle Daybreak; for example, dis-
bursing escrow to a customer, disbursing escrow to insur-
ance, and receiving payment.

TEN ESCROW NON MONETARY TRANSACTIONS 
These transaction codes do not have a direct affect on the 
monetary value of an escrow account, but are used in 
maintaining account information, such as changing insur-
ance maturity date and adding new escrow tax details.

FST FEE ASSESSMENTS 
These transactions codes determine if fees are to be 
applied, such as nonsufficient funds fees or membership 
fees.

TES ESCROW ANALYSIS AND DISBURSEMENTS
These transaction codes allow for reviewing and approv-
ing escrow analysis, stopping an escrow override, and 
posting escrow disbursement.

The Transaction Code block records the following about each transaction in a super group.

• Is the transaction monetary or nonmonetary?
• Does Oracle Daybreak complete the transaction in real time or later as a batch pro-

cess?
• Does Oracle Daybreak perform this transaction automatically or can a user complete 

the transaction manually (Is the transaction available on the Maintenance (3) master 
tab on the Customer Service form?)

• Is the transaction to appear on customer statements?
• Does the transaction effect the general ledger?
• Is the transaction in use (enabled)?

Three sub pages, Parameters, Access Grid, and Products, record any additional informa-
tion required to perform a transaction, the user types that can perform the transaction, and 
the product type to which the transaction codes apply.
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To set up the Txn Codes page

1 On the Setup menu, choose Administration > System.

2 Choose the Txn Codes tab.

3 In the Transaction Super Group block, select the Super Group.

4 In the Transaction Codes block, enter the following information:

In this field: Do this:

Txn Code Enter the transaction code (required).
Description Enter the description for the transaction (required).
Group Select the transaction group (the group within the Trans-

action Super Group that the transaction code belongs to) 
(required).

Txn/Bal Type Select the transaction / balance type affected by the 
Transaction (required).

Statement Txn Type Select the statement transaction type (how the transaction 
should appear on the customer statement) (required).

Action Select the action type code for the transaction (what 
action will take place when the transaction occurs) 
(required).

5 If the transaction is a monetary transaction, select Monetary. If the transaction is a non-
monetary transaction, clear this box.

6 If the transaction is to be performed in a batch process, select Batch. 

7 If the transaction is a manual transaction (available through the Maintenance tab), select 
Manual. If you define a transaction as manual, i-flex solutions recommends that the trans-
action that reverses it also be defined as manual.

8 If the transaction is to be printed on customer statements, select Stmt Print.

9 If the transaction is a general ledger transaction, select GL.
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10 If the System Defined? Yes is selected, the entry is system defined. System defined 
entries cannot be modified. If the System Defined? No is selected, the entry is not system 
defined and it can be modified.

11 Select Enabled to enable the transaction.

12 Save your entry.

Txn Codes sub pages
The Txn Codes page contains three sub pages: Parameters sub page, Access Grid sub 
page, and Products sub page.

IMPORTANT: Please contact your Implementation Manager before making any changes 
in these sub pages.

Parameters sub page
The Parameters sub page allows you to define the parameter information for the associated 
transaction. The Parameters sub page applies exclusively to these super groups:

• ACCOUNT MONETARY TXN
• ACCOUNT NON MONETARY TXN
• SECURITIZATION TXN 
• ESCROW MONETARY TRANSACTIONS 
• ESCROW NON MONETARY TRANSACTIONS 

(For manual transactions, these are the parameters loaded when you choose Load Param-
eters on the Maintenance page on the Customer Service form.)

CAUTION: Please treat the Parameters sub page as containing view only information. 
This is very sensitive data and should not be changed without first consulting i-flex solu-
tions.
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To set up the Parameters sub page

1 On the Setup menu, choose Administration > System.

2 Choose the Txn Codes tab, then choose the Parameters sub tab.

3 Enter the following information in the Transaction Parameters block:

In this field: Do this:

Parameter Select the parameter for the transaction code chosen 
above (required).

Default Enter the default value for the transaction parameter 
(value to initially populate, or used if no value is sup-
plied) (optional).

Sort Enter the sort order for the transaction parameter 
(required).

Displayed? Yes No Choose “Yes” if the parameter is displayed (in current 
use).

Required? Yes No Choose “Yes” if the parameter is required (You must 
choose Yes, as empty values are not allowed).

4 Save your entry.
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Access Grid sub page
The Access Grid sub page allows you to control access to each transaction according to 
user responsibility, account status, and account condition. It allows the administrator to 
control when these transactions may be conducted. Normally, you would create or modify 
the access based on either the user responsibility or account condition. Account status 
access is left unchanged.

To set up the Access Grid sub page

1 On the Setup menu, choose Administration > System.

2 Choose the Txn Codes tab, then choose the Access Grid sub tab.

3 Enter the following information in the Transaction User Access Definition block:

In this field: Do this:

Access Type Select the access grid function type (RESPONSIBILITY, 
ACCOUNT CONDITION, or ACCOUNT STATUS) that is 
being used to control the creation of the associated trans-
action (required).

Access Value Select the access function grid value (based on a lookup 
associated with the Access Type. Multiple entries for 
each access type may be created as long as each has a dif-
ferent access value) (required).

Allowed? Yes No Choose “Yes” if the access is allowed (indicates whether 
the current Access Type / Access Value may create the 
associated transaction).

System Defined? Yes No If Yes is selected, the entry is system defined. System 
defined entries cannot be modified. If No is selected, the 
entry is not system defined and it can be modified.

4 Save your entry.
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Products sub page
The Products sub page allows you to define the products to which the transaction codes 
apply. It allows the administrator to control if the associated transaction code will be avail-
able for use for specific product types and or funding types.

Normally, an Access Value of ALL is defined for one or more Access Types with a given 
Allowed (Yes or No) value. Additional Access Values are then defined for the same 
Access Types with the opposite Allowed (Yes or No) value. This controls access to the 
associated transaction.

To set up the Products sub page

1 On the Setup menu, choose Administration > System.

2 Choose the Txn Codes tab, then choose the Products sub tab.

3 In the Transaction Product Definition block, enter the following information.

In this field: Do this:

Product Type Select the product type associated with the transaction 
code chosen above (LEASE).

Funding Type Select the funding type associated with the transaction 
code chosen above (OPEN ENDED, CLOSE ENDED or 
ALL).

Allowed? Yes No Choose “Yes” if the transaction is allowed (indicates 
whether the current Access Type / Access Value may cre-
ate the associated transaction).

4 Save your entry.
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24 x 7 Accessibility
Oracle Daybreak allows continuous access to the Oracle Daybreak system, 24-hours-a-
day, 7-days-a-week (24 x 7). You can continue working in Oracle Daybreak and posting 
most transactions during batch processing. When you post a transaction on the Customer 
Service form’s Maintenance page and the transaction posting is deferred or cannot be 
posted at the present time, “SYSTEM UNDER MAINTENANCE. TRANSACTION POSTING 
DEFERRED” appears in the Results block.

If transaction posting is deferred, Oracle Daybreak automatically posts the transactions 
once it completes batch processing. Otherwise, Oracle Daybreak displays a message 
advising to post the transaction later.

24 x 7 accessibility is controlled by the following system parameter on the Administration 
form’s System page:

Parameter: Description:
CMN_SYSTEM_UNDER_MAINTENANCE SYSTEM UNDER MAINTENANCE

Oracle Daybreak uses two batch job sets to handle end of day (EOD) and beginning of day 
(BOD) processing.
1-23  Setup Guide - Consumer Lease Collection



SET-EOD: This is the first job to run in the nightly batch jobs at the end of the day. It 
marks Oracle Daybreak as being in “maintenance” mode, indicating that batch processing 
has started. Any transaction posted after the SET-EOD batch job starts will be either 
deferred or not allowed to be posted at the present time.

SET-BOD: This will be the fist batch job to run at the beginning of next day. It marks Ora-
cle Daybreak as being “available,” indicating that batch processing has completed. Oracle 
Daybreak will then return to all held transactions and post them in the chronological order 
in which they were entered.
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Data Files tab (File Definitions page)
The File Definitions page organizes information pertaining to the various output data files 
that Oracle Daybreak can generate. Oracle Daybreak uses the File Definition page to out-
line the file layouts of each data file produced within the system, including the length and 
data type of each column name.

These files are typically produced during the nightly process.

One major advantage for the system-defined data files is the format mask of each column 
name within each data file. A format mask is like a stencil that forces data input to be of 
the same format before accepting the data. The list of the data files is described below:

File Name: Description:
CUSTOMER_ACH CUSTOMER ACH
PRODUCER_ACH PRODUCER ACH
VENDOR_ACH VENDOR ACH
CUSTOMER_STATEMENT CUSTOMER STATEMENT
PRODUCER_STATEMENT PRODUCER STATEMENT
FORM_1098 IRS INTEREST REPORTING FORM 1098
FORM_HMDA HMDA
FORM_1099A IRS ACQUISITION OR ABANDONMENT OF SECURED 

PROPERTY FORM 1099 A
FORM_1099C IRS CANCELLATION OF DEBT FORM 1099 C
COUPON_BOOK COUPON BOOK ORDER
PAYEE_ACH PAYEE ACH

You can change the order in which the fields are displayed in the file.

Note: Any addition or removal of a field or change in the data type length will require i-
flex solutions involvement.

To set up the File Definitions page

1 On the Setup menu, choose Administration > System.

2 Choose the Data Files tab.

The Data File Definitions block defines specific data files. Each is associated with a spe-
cific Output Data Definition (ODD) batch job that gathers the data the file will contain. 
While new Data File Definitions may be created they will have no use unless a batch job is 
also created to populate the data.
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3 Complete the Data File Definitions block with the following information:

In this field: Do this:

Name Enter data file type (name of data file definition) 
(required).

Description Enter data file description (required).
File Name Enter data file name. Prefix used for files generated for 

this Data File. This is the only field in the Data File Defi-
nitions block that can or should be modified by your 
Administrator. The generated file name will be in the 
form of <FILE NAME>_<COMPANY ID>_<BRANCH 
ID>_<MMDDYYYY>_<PROCESS ID>.DAT. The inclu-
sion of _<COMPANY ID> and _<BRANCH ID> depends 
entirely on the associated batch process (required).

Directory Path Enter the location of the data file (required).
System Defined? Yes No If Yes is selected, the entry is system defined. System 

defined entries cannot be modified. If No is selected, the 
entry is not system defined and it can be modified.

Enabled Select to enable the data file definition.

Each Data File Definition is made up of one or more Record Definitions. These define 
organization of the data. The associated batch file determines how these records are used. 
The order in which the data is populated determines the order in which those records will 
appear in the output file. This is generally related to the order the records appear in the 
Data File Definition.

4 Complete the Record Definitions block with the following information:

In this field: Do this:

Record Type Enter the type of record being defined (required).
Description Enter record description (required).
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Record Format Select the format of output data (FIXED, VARIABLE) 
(required).

Delimiter Enter the delimiter (column separator used with VARI-
ABLE format) (required).

Terminator Select the record terminator code (how the end of each 
record is indicated within the file -- CARRIAGE 
RETURN, LINEFEED, or CARRIAGE RETURN AND 
LINEFEED) (required).

Each Record Definition is made up of one or more Column Definitions. These define the 
output the output of the data. Much of this data is informational; it indicates what data is 
being provided by the associated batch job. Unless otherwise noted, the data should not be 
changed without changing the associated batch job.

5 Complete the Column Definitions block with the following information:

In this field: Do this:

Seq Enter the sequence of how the output data will process 
the columns (required).

Column Name Enter name/description of the column name (informa-
tional only) (display only).

Data Type Select the data type. This describes the type of data the 
column is expected to contain (CHARACTER, DATE, or 
NUMBER). This effects how the ODD process handles 
the data, and should not be changed (display only).

Format Mask Select the format mask for the column. For DATE or 
NUMBER columns, this field defines the output format of 
the data. For example, Date fields may be entered using 
the MM/DD/YYYY format, and Number fields may be 
entered as decimal numbers with varying degrees of pre-
cision. Other formats for each data type are available 
(required).

Length Enter the column length. The number of characters of the 
data contained in the output data to be included in the 
output file. Each output data details column may contain 
up to 240 characters of data. If the output data details col-
umn contains more data than the length value the data 
will be truncated. For VARIABLE records the length 
should be set to “-1” or a Delimited file will be created 
with FIXED LENGTH columns (required).

Data Column Enter the data column sequence. This is the column that 
will be used to select the data that is being output. This 
should not be changed (required).

Output Column Enter the output column sequence. This is the column 
that will appear in Output File. The Output Data Dump 
process allows for the output of 250 columns of data per 
record. No output column should be repeated in the setup 
for a record (required).

6 Save your entry.
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Error Messages tab (Error Messages page)
With the Error Messages tab’s Error Messages page, you can translate or modify the text 
of error messages. Oracle Daybreak displays all messages as they appear to Oracle Day-
break users in the Error Message block’s Message field. 

New messages created with the Error Messages page can then be translated with the 
Translation tab’s Message Translation page.

To set up the Error Messages page

1 On the Setup menu, choose Administration > System.

2 Choose the Error Messages tab.

3 In the Error Type block, use the Error Type field to select the error type. These are the cat-
egories of error messages available for creating or editing.

The error messages associated with the error type you selected appear in the Error Mes-
sage block.

4 In the Error Message block, select the message you want to modify or insert a new record 
to create a new error message.

5 Edit or complete the record in the Error Message block the following information:

In this field: Do this:

Region Enter the region code (required).
Country Enter the country code (required).
Customer Enter the customer code (required).
Engine Enter the engine code (required).
Error Code Enter the error code (required).
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System Defined (Yes/No) Displays whether or not the record is system defined. 
Message Enter the error message (required).
Enabled Select to enable the data error message.

6 Save your entry.

Translation tab (Setup Translation page)
With the Translation tab’s Setup Translation page, you can translate the contents of a pre-
defined list of setup description fields into a different language. 

After you translate an entry in the Translation Data block, Oracle Daybreak adds the new 
data to the setup form. 

To set up the Setup Translation page

1 On the Setup menu, choose Administration > System.

2 Choose the Translation tab, then choose the Setup Translation tab.

3 In the Language block, select the language for which the translation needs to be done. 

Note: For more information, see Language setup at the end of this chapter.

4 In the Source Type block’s Source Type field, select the source (or location in Oracle 
Daybreak) of the item you want to translate.
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5 In the View Translation block, choose:

• All to view all the records (both translated and un-translated) in the Translation Data block
-or-

• Translated to view all the translated records in the Translation Data block.
-or-

• Un Translated to view all the un-translated records in the Translation Data block.

6 Choose Populate Details in the Source Type block and Oracle Daybreaks loads the setup 
data descriptions in the Translation Data block for the source type in the Source Type 
block.
-or-
Choose Populate All in the Language block and Oracle Daybreak loads the setup data 
description in the Translation Data block for all setup items for translation.

Note: If new records are added to setup (for example, new pricing strings added to the 
Product Management form’s Pricing page), the next time you choose Populate Details in 
the Source Type block, the new records (in this case, the new pricing strings) appear in the 
Translation Data block. These new entries have no impact on the previously translated 
data, they simply appear as additional entries available for translation.

The next time you choose Populate Details in the Source Type block, the new entry 
appears in the Translation Data block with no impact to the previously translated data.

If you are unsure as to which setup items have been updated since the last translation, 
choosing Populate All loads the additional data for all items with no impact to the previ-
ously translated data for any of the entries.

7 To work with an individual record in the Translation Data block, choose the Lock/Unlock 
Record button in the Oracle Daybreak tool bar 
-or 
To work with multiple records in the Translation Data block, choose the Unlock All com-
mand button.

When you choose Unlock All, Oracle Daybreak displays a Forms dialog box with the 
message “Changing setup may cause data inconsistency, Do you want to continue?” If you 
choose Yes, Oracle Daybreak allows you and changes the Unlock All button to the Lock 
All button.

8 In the Translation Data block, select the record you want to modify.

9 Edit the record in the Translation Data block with the following information:

In this field: Do this:

Key 1 View the first reference key value (display only).
Key 2 View the second reference key value (display only).
Key 3 View the third reference key value (display only).
Key 4 View the fourth reference key value (display only).
Key 5 View the fifth reference key value (display only).
Key 6 View the sixth reference key value (display only).
System Defined (Yes/No) Displays whether or not the record is system defined. 
Enabled If selected, indicates the record is active.
Desc 1 (English) View the first English description (display only).
Desc 2 (English) View the second English description (display only).
Desc 3 (English) View the third English description (display only).
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Desc 4 (English) View the fourth English description (display only).
Translation Desc 1 Enter the first translated description (required).
Translation Desc 2 Enter the second translated description (optional).
Translation Desc 3 Enter the third translated description (optional).
Translation Desc 4 Enter the fourth translated description (optional).

10 If you changed an individual record in the Translation Data block, choose the Lock/
Unlock Record button in the Oracle Daybreak tool bar 
-or 
If you changed multiple records in the Translation Data block, choose the Lock All com-
mand button.

11 Save your entry.

Translation tab (Message Translation page)
With the Translation tab’s Message Translation page, you can translate the contents of a 
predefined list of error messages into a different language.

After you translate an entry in the Error Message block, Oracle Daybreak adds the new 
data to the error message. 

To set up the Message Translation page

1 On the Setup menu, choose Administration > System.

2 Choose the Translation tab, then choose the Message Translation tab.

3 In the Language block, select the language for which the translation needs to be done. 

Note: For more information, see Language setup at the end of this chapter.
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4 In the Error Type block’s Error Type field, select the type of error message you want to 
translate.

5 In the View Translation block, choose:

• All to view all the records (both translated and un-translated) in the Error Message block
-or-

• Translated to view all the translated records in the Error Message block.
-or-

• Un Translated to view all the un-translated records in the Error Message block.

6 Choose Populate Details in the Error Type block and Oracle Daybreaks loads the error 
messages in the Error Message block for the selected error type in the Error Type block.
-or-
Choose Populate All in the Language block and Oracle Daybreak loads the error mes-
sages in the Error Message block for all error types for translation.

Note: If new error messages are added to setup, the next time you choose Populate Details 
in the Error Type block, the new records appear in the Translation Data block. These new 
entries have no impact on the previously translated data, they simply appear as additional 
entries available for translation.

The next time you choose Populate Details in the Source Type block, the new entry 
appears in the Translation Data block with no impact to the previously translated data.

If you are unsure as to which error messages have been updated since the last translation, 
choosing Populate All loads the additional data for all items with no impact to the previ-
ously translated data for any of the entries.

7 To work with an individual record in the Error Message block, choose the Lock/Unlock 
Record button in the Oracle Daybreak tool bar 
-or 
To work with multiple records in the Error Message block, choose the Unlock All com-
mand button.

When you choose Unlock All, Oracle Daybreak displays a Forms dialog box with the 
message “Changing setup may cause data inconsistency, Do you want to continue?” If you 
choose Yes, Oracle Daybreak allows you and changes the Unlock All button to the Lock 
All button.

8 In the Error Message block, select the record you want to modify.

9 Edit the record in the Error Message block with the following information:

In this field: Do this:

Region View the region code (display only).
Country View the country code (display only).
Customer View the customer code (display only).
Engine View the engine name (display only).
Error Code View the error code (display only).
System Defined (Yes/No) Displays whether or not the record is system defined. 
Enabled If selected, indicates the record is active.
Message (English) View the error message (display only).
Message (Translation) Enter the translated description (required).
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10 If you changed an individual record in the Error Message block, choose the Lock/Unlock 
Record button in the Oracle Daybreak tool bar 
-or 
If you changed multiple records in the Error Message block, choose the Lock All com-
mand button.

11 Save your entry.

Language setup
On the Administration form’s Lookups page, you can add other languages to the 
TRD_LANGUAGE_CD lookup type and perform translations for those languages. 

However, translated data only appears in one language, which is defined by the User Lan-
guage parameter. This parameter can be defined in a Oracle Daybreak configuration file, 
typically named DBKWEB.CFG, which defines the parameter as:

Parameter: otherparams=ORA_USER=<schema_name> USR_LANG=<native language>

Note: <native language> should match lookup codes in the TRD_LANGUAGE_CD lookup 
type on the Administration form’s Lookups page.
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Oracle Daybreak supports the following pre-defined list of setup items for translation:

1. Asset Sub Types
2. Asset Types
3. Assignments
4. Audit Table Columns
5. Audit Tables
6. Call Action Result Types
7. Call Action Types
8. Checklist Action Types
9. Checklist Types
10. Commission Plans
11. Companies
12. Company Branch Departments
13. Company Branches
14. Compensation Plans
15. Credit Bureau Score Reasons
16. Credit Models
17. Credit Scoring Parameters
18. Edits
19. Escrow Disburse Rules
20. Escrow Sub Types
21. Flex Table Attributes
22. Flex Tables
23. GL Transaction Types
24. GL Translators
25. Job Sets
26. Jobs
27. Lookup Codes
28. Lookup Types
29. Portfolio Companies
30. Portfolio Company Branches
31. Producers
32. Product Instruments
33. Product Insurances
34. Product Pricings
35. Products
36. Promotions
37. Spreads
38. Standard Correspondences
39. Standard Document Definitions
40. Standard Element Definitions
41. Standard Function Definitions
42. Transaction Codes
43. Error Messages
44 Org. Fees
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CHAPTER 2 : ADMINISTRATION (USER) FORM

The Administration form’s User master tab and its pages contain setup data that defines 
your organization structure and its users. Information on the User master tab is more 
“data” related, whereas the information stored on the System master tab functions more 
like switches that control system behavior.

The Administration form’s User master tab contains the following tabs:

• Organization
• Companies
• Access
• Users
• Printers
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Organization tab (Organization page)
The Organization page records the operational hierarchy of your business in terms of peo-
ple. It groups the human resources of your business in three categories: organization, divi-
sion, and department. Oracle Daybreak uses this data to control who has access to which 
accounts. (The Companies page allows you to set up where those accounts are located.) 

Please note that in completing the Organization page, there is can be only one active orga-
nization, so use the Organization Definition block to define your organization at its highest 
level.

Divisions are groups within your organization that will have access to the same accounts. 
Larger organizations often define their divisions by region. Smaller organizations may 
define division as branch offices or even departments, and might only have one division 
defined.

Departments are smaller units within a division. They expand on who is in the correspond-
ing Division Definition block. Oracle Daybreak uses this block, for example, when setting 
up the Services page on the Utility form (Monitor > System > Services) and the Printers 
page on the Administration form (Setup > Administration > User). At least one depart-
ment must be defined for each division.

As an example of an organization setup, i-flex solutions Corp. might be defined as:

Organization: O-0001 ABC Corp. ABCC

Division: OD-001 Central Region C01

Department: ODD-01 Origination ORG
Department: ODD-02 Funding FUN
Department: ODD-03 Servicing SER

Division: OD-002 Eastern Region E01

Department: ODD-11 Servicing SER
Department: ODD-12 Collection COL

Note: The Short Name field on the Organization page allows you to create the ID that Ora-
cle Daybreak will use when referring to the organization, division, and department 
throughout the system. 
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To set up the Organization page

1 On the Setup menu, choose Administration > User.

2 Choose the Organization tab.

3 Enter the following information in the Organization Definition block. There can be only 
one active entry, so use this block to define your organization at its highest level.

In this field: Do this:

Organization Enter the organization ID. (The ID is the unique identifier 
used internally by Oracle Daybreak to represent your 
organization). Note: Do not edit this field (required).

Organization Name Enter the organization name (required).
Short Name Enter the short name for the organization (Note: This is 

the ID that appears throughout Oracle Daybreak to repre-
sent this organization) (required). 

Address Enter the address line 1 for the organization (required).
Address 2 (unlabeled) Enter the address line 2 for the organization (optional).
Zip Select the zip code where the organization is located 

(required).
City Enter the city where the organization is located (required)
St Select the state where the organization is located 

[STATE_CD] (required).
Zip Extension (unlabeled) Enter the zip extension where the organization is located 

(optional).
Country Select the country where the organization is located 

[COUNTRY_CD] (required).
Phone Enter the primary phone number for the organization 

(required).
Ext Enter the phone extension for the primary phone number 

(optional).
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Fax Enter the primary fax number for the organization 
(required).

Phone Enter the alternate phone number for the organization 
(optional).

Ext Enter the phone extension for the alternate phone number 
(optional).

Fax Enter the alternate fax number for the organization 
(optional).

License Key Enter software license key (unique license key for Oracle 
Daybreak that determines the organization’s access to the 
system) (CAUTION: Do not touch!) (required).

4 Select Enabled to enable the organization. Note: Only one enabled organization is cur-
rently allowed by Oracle Daybreak.

5 In the Division Definition block, record the groups within your organization that will have 
access to the same accounts:

In this field: Do this:

Division Enter the division id. (The ID is the unique identifier 
used internally by Oracle Daybreak to represent the divi-
sion within the organization). Note: Do not edit this field 
(required).

Division Name Enter the division name (required).
Short Name Enter the short name for the division (Note: This is the 

ID that appears throughout Oracle Daybreak to represent 
this division) (required)

Address Enter the address line 1 for the division (required).
Address 2 (unlabeled) Enter the address line 2 for the division (optional).
Zip Select the zip code where the division is located 

(required).
City Enter the city where the division is located (required).
St Select the state where the division is located 

[STATE_CD] (required).
Zip Extension (unlabeled) Enter the zip extension where the division is located 

(optional).
Country Select the country where the division is located 

[COUNTRY_CD] (required).
Phone Enter the primary phone number for the division 

(required).
Ext Enter the phone extension for the primary phone number 

(optional).
Phone Enter the alternate phone number for the division 

(optional).
Ext Enter the phone extension for the alternate phone number 

(optional).
Fax Enter the primary fax number for the division (required).
Fax Enter the alternate fax number for the division (optional).

6 Select Enabled to enable the division.
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7 In the Department Definition block, enter the following information:

In this field: Do this:

Department Enter the department ID. (The ID is the unique identifier 
used internally by Oracle Daybreak to represent the 
department within the division) (required).

Department Name Enter the department name (required).
Short Name Enter the short name for the department (Note: This is 

the ID that appears throughout Oracle Daybreak to repre-
sent this department) (required)

Address Enter the address line 1 for the department (required).
Address 2 (unlabeled) Enter the address line 2 for the department (optional).
Zip Select the zip code where the department is located 

(required).
City Enter the city where the department is located (required).
St Select the state where the department is located 

[STATE_CD] (required).
Zip Extension (unlabeled) Enter the zip extension where the department is located 

(optional).
Country Select the country where the department is located 

[COUNTRY_CD] (required).
Phone Enter the primary phone number for the department 

(required).
Ext Enter the phone extension for the primary phone number 

(optional).
Phone Enter the alternate phone number for the department 

(optional).
Ext Enter the phone extension for the alternate phone number 

(optional).
Fax Enter the primary fax number for the department 

(required).
Fax Enter the alternate fax number for the department 

(optional).

8 Select Enabled to enable the department. 

9 Save your entry.
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Companies tab (Companies page)
The Companies page records the hierarchical structure of your portfolio companies and 
their branches. Just as Oracle Daybreak uses the Organization page to determine the loca-
tion of people, it uses the information on the Companies page to determine the location of 
accounts. In completing the Companies page, there can be more than one company, and 
each company can have more than one branch.

Accounting is performed at the company level. Accounts can be sorted down to the branch 
level. For this reasons, branches are set up to reflect differing business practices. You 
would set up different branches if, for example:

• The General Ledger (GL) differs between branches
• The branches work with different accounts
• There is a difference between branches in terms of the tasks they perform (lease col-

lections)

As an example of the companies setup, i-flex solutions Corp. might have the following 
companies and branches defined as:

Company: C-0001 TrustOne Financial Corp TOFC

Branch: CB-01 TOFC - Headquarters HQ
Branch: CB-02 Kennedy Plaza KP

Company: C-0002 Credtyme Credit Corp CCC

Branch: CB-11 CCC - Headquarters HQ
Branch: CB-12 CCC - Missoula MT

Note: Oracle Daybreak does not limit the number of companies or associated branches 
with the company you can enter.
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Note: The Short Name field in the on the Companies page allows you to create the ID that 
Oracle Daybreak will use when referring to the company and branch throughout the sys-
tem. 

KEY CONCEPT: Please note the difference between the Company page and the Organiza-
tion page:

• On the Organization page, Oracle Daybreak users belong to an organization, divi-
sion, and department.

• On the Companies page, credit accounts belong to a company and branch.

As you will see in the following Access page section, the information on the Organization 
and Companies pages define the operational hierarchy of your companies in terms of 
which Oracle Daybreak users will have access to which accounts.

To set up the Companies page

1 On the Setup menu, choose Administration > User.

2 Choose the Companies tab.

3 The Company Definition block defines entities within your organization that service 
loans. Enter the following information in the Company Definition block:

In this field: Do this:

Company Enter the portfolio company ID. (The ID is the unique 
identifier used internally by Oracle Daybreak to represent 
the company) (required).

Name Enter the name of the portfolio company (required).
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Short Name Enter the short name for the portfolio company (ID dis-
played to represent the company) (required).

Address Enter the address line 1 for the portfolio company 
(required).

Address 2 (unlabeled) Enter the address line 2 for the portfolio company 
(optional).

Zip Select the zip code where the portfolio company is 
located (required).

City Enter the city where the portfolio company is located 
(required).

St Select the state where the portfolio company is located 
[STATE_CD] (required).

Zip Extension (unlabeled) Enter the zip extension where the portfolio company is 
located (optional).

Country Select the country where the portfolio company is located 
[COUNTRY_CD] (required).

Contact Enter the contact information about the portfolio com-
pany (required).

Phone Enter the primary phone number for the portfolio com-
pany (required).

Ext Enter the phone extension for the primary phone number 
(optional).

Fax Enter the primary fax number for the portfolio company 
(required).

Phone Enter the alternate phone number for the portfolio com-
pany (optional).

Ext Enter the phone extension for the alternate phone number 
(optional).

Fax Enter the alternate fax number for the portfolio company 
(optional).

TCC Enter the transmitter control code for the portfolio com-
pany (1098 Electronic Filing) (required).

Tax Id Enter the tax identification number for the portfolio com-
pany (required).

Remittance Address Enter the remittance address line 1 (may be different 
from the company address). This address is included as 
the remittance address on statements (required).

Remittance Address 2 Enter the remittance address line 2 (optional).
(unlabeled)
Zip Select the zip code (required).
City Enter the remittance address city (required).
St Select the remittance address state [STATE_CD] 

(required).
Zip Extension (unlabeled) Enter the remittance address zip extension (optional).
Country Select the remittance address country [COUNTRY_CD] 

(required).
HMDA Select the HMDA agency (Home Mortgage Disclosure 

Act reporting agency for the company) 
[HMDA_AGENCY_CD] (required).

Coupon Order Code If you are using coupons, enter the coupon order code to 
be used by a third party printing the coupons for billing 
statements (required).
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4 Select Enabled to enable the portfolio company.

5 In the Branch Definition block, enter the following information: 

In this field: Do this:

Branch Enter the portfolio branch id. (The ID is the unique iden-
tifier used internally by Oracle Daybreak to represent the 
branch within your company) (required).

Name Enter the name of the portfolio branch (required).
Short Name Enter the short name for the portfolio branch (ID dis-

played to represent the branch) (required).
Address Enter the address line 1 for the portfolio branch 

(required).
Address 2 (unlabeled) Enter the address line 2 for the portfolio branch 

(optional).
Zip Select the zip code where the portfolio branch is located 

(required).
City Enter the city where the portfolio branch is located 

(required).
St Select the state [STATE_CD] (required).
Zip Extension (unlabeled) Enter the zip extension where the portfolio branch is 

located (optional).
Country Select the country [COUNTRY_CD] (required).
Phone Enter the primary phone number for the portfolio branch 

(required).
Ext Enter the phone extension for the primary phone number 

(optional).
Fax Enter the primary fax number for the portfolio branch 

(required).
Phone Enter the alternate phone number for the portfolio branch 

(optional).
Ext Enter the phone extension for the alternate phone number 

(optional).
Fax Enter the alternate fax number for the portfolio branch 

(optional).

6 Select Enabled to enable the portfolio branch.

7 Save your entry.
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Access tab (Data page)
Using the organizations, divisions, companies, and branches created on the Organization 
and Companies pages, Oracle Daybreak allows you to control which users have access to 
which accounts. The Data page is where you define which organization/division (Oracle 
Daybreak users) can gain access to which company/branch (accounts) locations. 

Normally, for each division within the one organization, you would define a record with 
Company value of ALL and a Branch value of ALL, then select the Allowed box. You then 
define other records for the same Organization and Division for other Company and 
Branch combinations with the Allowed box cleared to restrict access.
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To set up the Data page

1 On the Setup menu, choose Administration > User.

2 Choose the Access tab, then choose the Data tab.

3 Enter the following information on the Data page. 

In this field: Do this:

Access Grid block:
Organization Select the organization for which you are defining access 

privileges (required).
Division Select the division within the organization for which you 

are defining Access privileges (required).
Company Select the portfolio company to which you are defining 

access privileges for the organization and division speci-
fied (required).

Branch Select the portfolio branch of the company to which you 
are defining access privileges for the organization and 
division specified (required).

Allowed Select to indicate whether access to the data pertaining to 
the company and branch is allowed for the organization 
and division specified.

4 Save your entry.
2-11  Setup Guide - Consumer Lease Collection



Access tab (Menu page)
The Menu page allows you to restrict access to menus and commands on the Oracle Day-
break menu bar. If your responsibility does not have access to the menu or command, the 
menu item appears dimmed and inoperable.

To set up the Menu page

1 On the Setup menu, choose Administration > User.

2 Choose the Access tab, then choose the Menu tab.

3 Enter the following information on the Menu page. 

In this field: Do this:

Menu block:
Menu Code View the menu code (display only).
Description View the description for the menu code (display only).
Enabled If selected, indicates that the menu code is enabled.

Menu User Access Definition block:
Access Type Enter the access grid function type (required).
Access Value Enter the access function grid value (required).
Allowed? Yes/No Select Yes to allow access or No to restrict access to the 

menu code in the Menu block based on the access type 
and value.

System Defined Yes/No If Yes is selected, the menu user access definition entry is 
system defined.
If Yes is selected, the menu user access definition entry is 
manually defined. 

4 Save your entry.
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Access tab (Screen page)
The Screen page allows you to restrict access to tabs and sub tabs on Oracle Daybreak 
forms. 
If you do not have the responsibility to access to particular tab on a Oracle Daybreak form, 
the tab with be unavailable (dimmed). 

If you do not have the responsibility to access to all the tabs at particular level, then special 
“No Access” tab appears on that level with the message “Sorry, you do not have access to 
view this information.”

To set up the Screen page

1 On the Setup menu, choose Administration > User.

2 Choose the Access tab, then choose the Screen tab.

3 Enter the following information on the Screen page. 

In this field: Do this:

Screen block:
Screen Name Search for and view the form you want to work with (dis-

play only).

Screen Details block:
Tab Name Search for and view the object name you want to work 

with (display only).
Parent Tab Name View the parent object name (display only).
Enabled If selected, indicates the selected screen detail entry is 

enabled.

Screen User Access Definition block:
Access Type* Enter the access grid function type (required).
Access Value* Enter the access function grid value (required).
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Allowed? Yes/No Select Yes to allow access or No to restrict access to the 
object in the Screen Details block based on the access 
type and value.

System Defined Yes/No If Yes is selected, the screen user access definition entry 
is system defined.
If Yes is selected, the screen user access definition entry 
is manually defined. 

4 Save your entry.

Access tab (Correspondence page)
The Correspondence page allows you to restrict access to different correspondence com-
mands on the Letters menu, thus restricting your ability to generate certain correspon-
dence.

If you do not have the responsibility to create to type of correspondence, the correspond-
ing command on the Letters menu is unavailable (dimmed). 

To set up the Correspondence page

1 On the Setup menu, choose Administration > User.

2 Choose the Access tab, then choose the Correspondence tab.

3 Enter the following information on the Correspondence page. 

In this field: Do this:

Correspondence Codes block:
Code Search for and view the correspondence code name you 

want to work with (display only).
Description View the description for the correspondence code (dis-

play only).
Enabled If selected, indicates the selected correspondence code 

entry is enabled.

Correspondence User Access Definition block:
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Access Type Enter the access grid function type (required).
Access Value Enter the access function grid value (required).
Allowed? Yes/No Select Yes to allow access or No to restrict access to the 

entry in the Correspondence Codes block based on the 
access type and value.

System Defined Yes/No If Yes is selected, the correspondence user access defini-
tion entry is system defined.
If Yes is selected, the correspondence user access defini-
tion entry is manually defined. 

4 Save your entry.

Access tab (Setup Security page)
The Setup Security page allows you to restrict access to the Lock/Unlock Record icon on 
the Oracle Daybreak tool bar, thus restricting your ability to edit fields on various pages 
and sub pages.

If you do not have the responsibility to lock/unlock based on the information on the Setup 
Security page, Oracle Daybreak displays a Forms dialog box with the message “User 
responsibility not allowed to lock/unlock” on the Letters menu is unavailable (dimmed). 

To set up the Setup Security page

1 On the Setup menu, choose Administration > User.

2 Choose the Access tab, then choose the Setup Security tab.

3 Enter the following information on the Setup Security page. 

In this field: Do this:

Lock/Unlock Codes block:
Code Search for and view the lock/unlock code you want to 

work with (display only).
Description View the description for the lock/unlock code (display 

only).
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Enabled If selected, indicates the selected lock/unlock code entry 
is enabled.

Lock/Unlock User Access Definition block:
Access Type Enter the access grid function type (required).
Access Value Enter the access function grid value (required).
Allowed? Yes/No Select Yes to allow access or No to restrict access to the 

entry in the Lock/Unlock Codes block based on the 
access type and value.

System Defined Yes/No If Yes is selected, the lock/unlock user access definition 
entry is system defined.
If Yes is selected, the lock/unlock user access definition 
entry is manually defined. 

4 Save your entry.

Access tab (Transaction page)
The Transaction page allows you to restrict access to the following types of monetary and 
nonmonetary transactions: 

• ACCOUNT MONETARY TXN
• ACCOUNT NON MONETARY TXN
• PRODUCER MONETARY TXN
• ACCOUNT CONDITION TXN
• SECURITIZATION TXN
• FEE ASSESSMENTS

To set up the Transaction page

1 On the Setup menu, choose Administration > User.

2 Choose the Access tab, then choose the Transaction tab.
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3 Enter the following information on the Transaction page. 

In this field: Do this:

Transaction Super Group block:
Super Group Search for and view the transaction supergroup you want 

to work with (display only).

Transaction Codes block:
Txn Name Search for and view the transaction code you want to 

work with (display only).
Description View the description for the transaction (display only).
Authorize Select if you want the transaction to be verified by a sec-

ond Oracle Daybreak user on the Transaction Authoriza-
tion form’s Authorization page.
In the Transaction User Access Definition block, use the 
Access Type RESPONSIBILITY to define the user type 
the authorization restriction applies to when entering the 
transaction.

Note: If the Authorization check box is cleared, the exist-
ing transaction posting process on the Maintenance (3) 
master block will apply; the transaction will be posted 
and the authorization process is by-passed.
For more information, please see the Memo Transaction 
Posting (Maker-Checker) chapter in the Oracle Day-
break User Guide.

Enabled If selected, indicates the transaction codes entry is 
enabled.

Transaction User Access Definition block:
Access Type Enter the access grid function type (required).
Access Value Enter the access function grid value (required).
Allowed? Yes/No Select Yes to allow access or No to restrict access to the 

entry in the Transaction Codes block based on the access 
type and value.

System Defined Yes/No If Yes is selected, the transaction user access definition 
entry is system defined.
If Yes is selected, the transaction user access definition 
entry is manually defined. 

4 Save your entry.
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Users tab (Users page)
The Users page allows you to create and set up each Oracle Daybreak user. In the User 
Definition block, you assign a user an identification name and password to log on to Ora-
cle Daybreak. You also assign the organization, division, and department where each user 
is located. Additional fields allow you to record information for contacting the user. You 
can also define the time frame within which a user has access to the system to ensure com-
pliance to the company’s schedule. This is a very useful feature to prevent logins during 
scheduled maintenance. 

The Responsibility field records the job function of the user and defines the level of access 
that user has within the system; in particular:

• What menu items does the user have access to?
• Can the user click the Lock/Unlock Record button on the Oracle Daybreak toolbar?
• What transactions can the user perform on the Maintenance (3) master tab on the Cus-

tomer Service form?
• What edits can the user perform on the Verification (9) master tab during lease origi-

nation?

Note: The Oracle Daybreak SUPERUSER responsibility grants access to the entire Oracle 
Daybreak system. Please give careful consideration to the number and type of users who 
receive this responsibility.

To set up the Users page

1 On the Setup menu, choose Administration > User.

2 Choose the Users tab.
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3 In the User Definition block, enter the following information for each user: 

In this field: Do this:

User Id Enter the user id. Note: This field is a unique indicator 
and cannot be updated, edited, or deleted once saved 
(required).

First Name Enter the first name of the user (required).
MI Enter the middle initial of the user (optional).
Last Name Enter the last name of the user (required).
Organization Select the organization to which the user belongs 

(required).
Division Select the division to which the user belongs (required).
Department Select the department to which the user belongs 

(required).
Start Dt Enter the start date for the user (required).
End Dt Enter the end date for the user (required).
System Defined? Yes No If Yes is selected, the entry is system defined. System 

defined entries cannot be modified. If No is selected, the 
entry is not system defined and it can be modified.

Responsibility Select the responsibility for the user 
[RESPONSIBILITY_CD] (required).

Password Enter the password for the user. (The password must be 
within the parameters defined on the Administration 
form’s System > Parameters > Organization page) 
(required).

Phone Enter the user’s primary phone number (required).
Phone Extension (unlabeled) Enter the phone extension for the primary phone number 

(optional).
Fax Enter the user’s primary fax number (required).
Email Enter user’s email address (optional).
Type Select the user type [USR_TYPE_CD] (required).
Reference # Enter the reference number. This is a free form field that 

allows you to further categorize users as you choose 
(required).

Phone Enter the user’s alternate phone number (optional).
Phone Extension (unlabeled) Enter the phone extension for the alternate phone number 

(optional).
Fax Enter the user’s alternate fax number (optional).
Replacement User* Select the user id of the replacement user (optional).
Dt* Enter the date from when the replacement is effective 

(optional).
*Note: These two allow you to create a replacement user 
for the current user. This is particularly useful when a 
new employee assumes the duties of a former. By com-
pleting the Replacement User and Dt field, Oracle Day-
break recognizes the replacement user as the current user 
on the effective date. For more information, see the fol-
lowing section, Replacement Users.

4 Select Enabled to enable the user.

5 Save your entry.
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Replacement users
By completing the Replacement User and Dt fields on the User Definition block of the 
Users page, you can replace an existing user with a new user. Oracle Daybreak assigns all 
responsibilities of the original Oracle Daybreak user to the new user as of the date of the 
replacement.

The Replacement User and Dt fields allow you to designate a replacement for the current 
user in the User ID field. When you complete the Replacement User and Dt fields, save 
your entry, and then enable the record, Oracle Daybreak replaces the original user. Oracle 
Daybreak changes the End Dt field to the date when the original user was replaced (the 
same date in the Dt field).

In the example below, User Id BJORN is the existing user replaced with Replacement User. 

Oracle Daybreak assigns the queues of the original user to only those replacement users 
who have the same user responsibilities (or Super User responsibility) as set in Oracle 
Daybreak. 

Oracle Daybreak updates the following when replacing users:

1 Oracle Daybreak assigns all applications in the replaced user’s underwriting queue 
with the status NEW to the replacement user’s queue. 

 
2 Oracle Daybreak assigns all applications in the replaced user’s funding queue with a 

status other than FUNDED to the replacement user’s queue. Oracle Daybreak currently 
stores the collector name in the back end tables, which are updated with the replace-
ment users ID in the case of the replacement of any user.   

3 Oracle Daybreak also updates the Producers page (Lending menu > Producers com-
mand > Producer master) with the replacement user in the Underwriter and Collector 
fields. Oracle Daybreak assigns all applications routed to the original user to the 
replacement user. This also includes any future applications for the replaced user.

4 Oracle Daybreak automatically updates the collector ID field in all accounts to the 
replacement user and routes all accounts assigned to the original user to the replace-
ment user. Note: Oracle Daybreak will not update the replacement user ID for 
accounts that are closed. 
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5 On the Queue Setup form’s Responsibilities and Users sub-page, the record for the 
original user will be disabled and a new record will be created for the replacement 
user. If the replacement user already exists in the setup, Oracle Daybreak will not cre-
ate a new record. Oracle Daybreak updates the user ID and routes all accounts that 
were assigned to the original user, based on the account condition, to the replacement 
user.

Enhanced password protection
Customer data is always vulnerable when passwords are simple enough for hackers to 
guess. This can happen in the absence of strict password rules. Oracle Daybreak supports 
flexible and more secured password rules with a set of additional organizational level 
password parameters. Setting all password parameters to Y enforces the strictest password 
complexity. 

These organization level password parameters are as follows:

Parameter Description
ULG_PWD_CASE_SENSITIVE_REQ PASSWORD SHOULD BE CASE SENSITIVE (Y/

N) (SET NO TO STORE PASSWORD IN UPPER-
CASE)

If the Parameter Value is set to N, the password 
will be treated as if entered in uppercase.

ULG_PWD_LOWER_CHAR_REQ PASSWORD MUST HAVE AT LEAST ONE LOW-
ERCASE CHARACTER (YES/NO)

If the Parameter Value is set to Y, at least one 
lowercase character is required in the password.

ULG_PWD_UPPER_CHAR_REQ PASSWORD MUST HAVE AT LEAST ONE 
UPPERCASE CHARACTER (YES/NO)

If the Parameter Value is set to Y, at least one 
uppercase character is required in the password.
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ULG_PWD_NBR_REQ PASSWORD MUST HAVE AT LEAST ONE 
NUMERIC CHARACTER (0-9) (YES/NO)

If the Parameter Value is set to Y, at least one 
numeric character is required in the password.

ULG_PWD_SPECIAL_CHAR_REQ PASSWORD MUST HAVE AT LEAST ONE SPE-
CIAL CHARACTER ($#@ ETC) (YES/NO)

If the Parameter Value is set to Y, at least one 
special character is required in the password.

Note: IF THE ULG_PWD_CASE_SENSITIVE_REQ parameter is set to N, then the 
ULG_PWD_LOWER_CHAR_REQ parameter should also be set to N.

Password security is a top priority for any organization to secure its customer data. In 
addition to the existing Oracle Daybreak security features, the encryption algorithm DES3 
makes it even tougher for hackers to break the encrypted password.

Password encryption can be done with the following methods:

1. DES (data encryption standard)
2. DES3 (triple data encryption standard)

A technical note about DES and DES3: DES is a symmetric key cipher (encryption 
algorithm); that is, the same key is used to encrypt data as well as decrypt data. DES 
encrypts data in 64-bit blocks using a 56-bit key. The banking industry has adopted DES 
based standards for transactions between private financial institutions, and between pri-
vate financial institutions and a private individual. 

Triple DES (DES3) is a far stronger cipher than DES. The resulting encrypted data is 
much harder to break using exhaustive search 2**168 attempts as compared to 2**56 
attempts (in the case of DES). 

You can specify the encryption type to use with your Oracle Daybreak system using the 
following system parameter.

Parameter Description
PASSWORD_ENCRYPTION_TYPE   PASSWORD ENCRYPTION TYPE
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Printers tab (Printers page)
The Printers page allows you to set up an unlimited number of network printers and fax 
devices to be used with the system server. Oracle Daybreak will use the information on 
this page when selecting a printer when the printing process involves a batch job or use a 
job scheduler. Examples include printing reports and correspondence. 

The printers and fax devices can be set up at each organization, division, or department to 
promote efficient printing of documents, and reports. Oracle Daybreak uses this informa-
tion during product setup and on the Letters page in the Batch Printer field.

Special printer names
The following printer names are predefined and have specific functions within Oracle 
Daybreak:

UNDEFINED Indicates that the document to be printed is to be previewed in 
your browser instead of actually printing the document.

ARCHIVE Instead of sending an item to the printer, Oracle Daybreak gener-
ates a PDF document and saves it in the archive directory on your 
server.

EMAIL For lease origination correspondences that can be faxed, Oracle 
Daybreak will e-mail the document as a PDF attachment to the 
consumer for direct loans or to the producer in the case of in-
direct loans.

FAX For lease origination correspondences that can be faxed, Oracle 
Daybreak generates a PDF document it will send to the fax server 
defined in System Parameters.

Additionally, you may set up composite entries in the Printer Name field to perform two or 
more functions at the same time. This can be done by defining a printer name with the fol-
lowing format:

PRINTER NAME = <PRINTER_NAME1> + <PRINTER_NAME2>

For example, if a printer named JET4050 was previously defined, as were the special 
printer names listed above, then the following additional printers could be defined:

JET4050+ARCHIVE Prints the document with the jet4050 printer and 
archives the document.

FAX+ARCHIVE Faxes and archives the document.
EMAIL+ARCHIVE+JET4050 E-mails, archives, and prints the document with 

the jet4050 printer.
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To set up the Printers page

1 On the Setup menu, choose Administration > User.

2 Choose the Printers tab.

3 In the Printer Definition block on the Printers page, enter the following information:

In this field: Do this:

Printer Name Enter the printer name. The name of the printer as 
defined by the server. For a UNIX server, the name might 
be JET4050, while to access the same printer from a Win-
dows server the name would be: \\server-
name\jet4050 (required).

Description Enter the description for the printer (required).
Organization Select the organization to which the printer belongs 

(required).
Division Select the division to which the printer belongs 

(required).
Department Select the department to which the printer belongs 

(required).

IMPORTANT: In selecting which printer to use, Oracle 
Daybreak searches for a best match using the following 
attributes:

1 Organization
2 Division
3 Department

For this reason, i-flex solutions recommends creating one 
version of each edit where ALL is the value in these 
fields.

It is also recommended that you define a default printer 
for an Organization, Division and Department.

4 Select the Default box on one entry to indicate that this printer is a default printer.

5 Select Enabled to enable the printer and indicate that the printer is active. 

IMPORTANT: Never disable the UNDEFINED printer. This is a required entry.

6 Save your entry.
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CHAPTER 3 : PRODUCT SETUP FORM 
The Product Setup form enables you to configure the basic business guidelines necessary 
to support one or more leases products in Oracle Daybreak. This includes defining the 
types of collateral your company supports, creating lending instruments, and determining 
what is included in credit bureau reporting. Setting up the Products form requires a thor-
ough understanding of the current rules of your business and must be completed before 
you can use Oracle Daybreak.

The Products form contains the following four master tabs:

Master tab: Purpose:

Setup Records data that is common to lease supported 
by Oracle Daybreak.

Lease Allows you to set up the closed ended leases 
your company offers.

This chapter explains how to set up the Product Setup form’s Setup master tab, informa-
tion common to leases:

• Assets tab (Assets page)
• Scoring Parameters tab (Scoring Parameters page)
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Setup master tab
The Setup master tab records data that is common to lease products supported by Oracle 
Daybreak and contains the following pages: Assets, Scoring Parameters.

Assets tab (Assets page)
The Assets page allows you to set up the asset types that can serve as an account’s collat-
eral.

The information on the Asset Type block is used by Oracle Daybreak to automatically 
display the appropriate collateral page (Vehicle, Home, or Other) on the Application Entry, 
Underwriting, Funding, Customer Service, and account boarding forms. 

Oracle Daybreak recognizes the following four types of collateral:

Collateral Type Description

Home collateral Homes, manufactured housing, or any real estate collat-
eral.

Vehicle collateral All vehicle types, such as cars, trucks, and motorcycles.
Unsecured collateral All unsecured lending instruments. (This collateral type 

makes the collateral tabs on Oracle Daybreak forms 
unavailable.)

Household goods and All other collateral types not defined as home, vehicle, or 
other collateral unsecured; for example, household items such as water 

heaters, televisions, and vacuums.

The Asset Sub Type block allows you to further categorize an asset; for example, the 
asset type VEHICLE might be categorized as CAR, TRUCK, or VAN. 

The Attributes/Addons and Makes and Models sub pages continue to further detail the 
asset both in description and value. For example, a VEHICLE asset might include addons 
such as LEATHER SEATS and CRUISE CONTROL. 

Note: Neither asset types nor asset sub types can be deleted. As they may have been used 
in the past, the display and processing of that data is still dependent on the existing setup.
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To set up the Assets page

1 On the Setup menu, choose Products > Setup.

2 Choose the Assets tab.

3 In the Asset Type block, enter the following information:

In this field: Do this:

Asset Type Enter the asset type (required).
Description Enter the description for the asset. (This is the asset type 

as it will appear throughout Oracle Daybreak) (required).
Example

Collateral Type Select the collateral type (the general category that the 
asset type falls within) [COLLATERAL_TYPE_CD]. 
Note: There is no need to define an asset for UNSE-
CURED COLLATERAL, as by definition there is no asset 
on such loans. (required).

Company Select the portfolio company to which the asset type 
belongs. These are the companies within your organiza-
tion that can make loans using this asset type. This may 
be ALL or a specific company (Setup > Administration 
> User > Companies) (required).

Branch Select the portfolio branch to which the asset type 
belongs. This is the branch within the selected company 
that can make loans using this asset type. This may be 
ALL or a specific branch (Setup > Administration > 
User > Companies). This must be ALL if in the Com-
pany field you selected ALL (required).
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IMPORTANT: In selecting which asset type to use, Ora-
cle Daybreak searches for a best match using the follow-
ing attributes:

1 Company
2 Branch

For this reason, i-flex solutions recommends creating one 
version of each asset type where ALL is the value in these 
fields.

Enabled Select to enable the asset type and indicate that the asset 
type is currently in use.

4 In the Asset Sub Type block, enter the following information:

In this field: Do this:

Asset Sub Type Enter the asset sub type (required).
Description Enter the description for the asset sub type. (This is the 

asset sub type as it appears throughout Oracle Daybreak) 
(required).
Example

Asset Property Type Select the asset property type. This field allows for prop-
erty type reporting [ASB_PROPERTY_TYPE_CD] 
(required).

Enabled Select to enable the asset sub type and indicate that the 
asset sub type is currently in use.

5 Choose the Attribute/Addons sub tab.

6 In the Asset Attributes block, enter the following information:

In this field: Do this:

Attribute/Addon View the asset attribute or addon name for the selected 
asset (display only).

Description Select the description for the asset attribute/addon 
[ASSET_ATTRIBUTE_TYPES_CD_OTHER] (required).

Default Enter the default text to be copied or displayed when the 
asset attributes and addons fields are completed on an 
application for this asset (optional).

Value $ Enter the default monetary value (in US $) to be copied 
or displayed when the asset attributes and addons fields 
are completed on an application for this asset (required).

Enabled Select to enable the asset attribute and indicate that it is 
available for this type of asset.

7 Choose the Makes and Models sub tab.
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8 In the Makes and Models block, enter the following information:

In this field: Do this:

Make Enter asset make (required).
Model Enter asset model (required).
Style Enter asset style type (optional).
Enabled Select to enable the asset make and model and indicate 

that it is included on LOVs for this asset type.

9 Save your entry.
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Scoring Parameters tab (Scoring Parameters page)
With the Scoring Parameters page, you can define the scoring parameters of a company’s 
credit scorecard and behavior scoring. 

Oracle Daybreak behavior scoring applies to accounts and is based on account history 
attributes and performed on a monthly basis. 

Behavior scoring 
Behavior scoring examines the repayment trends during the life of the account and pro-
vides a current analysis of the customer. This logical and systematic method identifies 
which accounts are more likely to perform favorably versus accounts where poorer perfor-
mance is probable. This is useful when determining which other lease products a customer 
may qualify for. 

This information appears on the Customer Service form in the Customer Service (2) mas-
ter tab’s Account Details page in the Activity block’s Behavior Score field.

 
Oracle Daybreak calculates behavior scores in a manner similar to how it calculates the 
Oracle Daybreak credit score during lease origination. In both cases, you create input 
parameters and define a formula on the Scoring Parameters page.
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To set up the Scoring Parameters page

1 On the Setup menu, choose Products > Setup.

2 Choose the Scoring Parameters tab.

3 In the Parameters block, enter the following information:

In this field: Do this:

Parameter Enter the name of the scoring parameter. i-flex solutions 
recommends entering a name that in some way reflects 
how the parameter is used; for example, use 
FICO_SCORE instead of PARAMETER_1. (required).

Description Enter a description of the parameter. Again, enter a name 
that reflects how the parameter is used; for example, use 
FICO SCORE and WEIGHTED FICO SCORE instead of 
FICO SCORE NUMBER 1 and FICO SCORE NUMBER 2 
(required).

Data Type Select the data type of the scoring parameter being 
defined - this determines how Oracle Daybreak handles 
the values. (While DATE and CHARACTER are available 
data types, generally only NUMBER should be used when 
defining a Scoring parameter [DATA_TYPE_CD] 
(required).

Scoring Type Select the scoring type: CREDIT SCORING or BEHAV-
IORAL SCORING (required).

Enabled Select to enable and indicate that the scoring parameter is 
available.
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4 Use the Formula Definition block to define a mathematical expression of the scoring 
parameter you want to define. The expression may consist of one or more sequenced 
entries. All arithmetic rules apply to the formula definition. If errors exist in the formula 
definition, Oracle Daybreak displays an error message in this block when you choose 
Show Expression.

When creating a behavior scoring formula in the Scoring Parameters page’s Formula Def-
inition block, use variables regarding account information (account variables begin with 
ACC_).

In this field: Do this:

Seq Enter the sequence number (the order in which the for-
mula definition variable will be assembled and evalu-
ated) (required).

( Enter a left bracket if you need to group part of your for-
mula definition (optional).

Variable Select variable from a validated LOV based on the user-
defined table SCR_CRED_SUMMARY: SCORING 
PARAMETERS (optional).

Constant Enter constant value (optional).
Mathematical Operator Select math operator to be used on the adjacent formula 

definition rows [MATH_OPERATOR_CD] (optional).
) Enter a right bracket if you are grouping part of your for-

mula definition (optional).
Enabled Select to enable the formula and indicate this it is 

included when building a definition for the scoring 
parameter.

 
5 Choose Show Expression.

The Variable Description field and Formula Expression block populate.

6 Save your entry.
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CHAPTER 4 : PRODUCT LEASE SETUP

The Product Setup form’s Lease master tab and its pages allow you to set up the closed 
ended s your company offers.The following tabs are available on the Lease master tab:

• Products 
• Scoring
• Contract
• Fees
• Checklists
• Statement
• Letters

This chapter explains how to setup the pages associated with each one.
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Products tab (Lease Products page)
The Products page defines the lease products your organization offers, such as lease vehi-
cles. The information on this page is the base for defining additional product information.

A lease product is based on the following attributes:

• The collateral type and sub type
• The billing cycle
• Whether the lease is paid directly or indirectly to the customer

The Product Definition block records details about the lease product, such as the descrip-
tion, collateral type and sub type, credit bureau reporting attributes, and billing cycle.

The Product Itemization block is used to define itemized entries for a lease product. This 
information is used on the Itemization sub pages of the Application Entry form, Fund-
ing form, Underwriting form, and Conversion forms. 

To set up the Products page

1 On the Setup menu, choose Products > Lease.

2 Choose the Products tab.

3 In the Product Definition block, enter the following information: 

In this field: Do this:

Product Enter the product code as defined by your organization 
(in other words, how you want to differentiate the lease 
products). For example, lease products can be differenti-
ated along asset lines (LEASE-VE for a vehicle). The 
product code, or name, is unique (required).

Description Enter the description of the product; for example, LEASE 
VEHICLE. (This is the product description as it appears 
throughout Oracle Daybreak) (required).
Example
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Collateral Type Select the collateral type for the product. This field iden-
tifies what type of collateral is associated with the lease 
and assists Oracle Daybreak in identifying the correct 
page(s) to display [COLLATERAL_TYPE_CD] (required).

Collateral Sub Type Select the collateral sub type for the product 
[COLLATERAL_SUB_TYPE_CD] (required).

Credit Bureau Portfolio Type* Select the credit bureau portfolio type for the product 
[CRB_PORTFOLIO_TYPE_CD] (required).

Credit Bureau Account Type* Select the account type for the product 
[CRB_ACC_TYPE_CD] (required).
*Note: The Credit Bureau Portfolio Type and Credit 
Bureau Account Type fields determine how the portfolio 
is reported back to the credit bureaus (required).

Billing Cycle Select the billing cycle for the product 
[LEASE_BILL_CYCLE_CD] (required).

Category Select the category for the product. This serves to group 
products for reporting purposes (user-defined). 
[PRODUCT_CATEGORY_CD] (optional).

Start Dt Enter the start date for the product (required).
End Dt Enter the end date for the product (required).

4 Select the Direct box if the product can be originated directly to customer. (In this case, 
the compliancy state is the state listed in the customer’s current mailing address.)
-or-
Clear the Direct box if the product is an indirect lending product; that is, payment is made 
to the producer. (In this case, the compliancy state is the state listed in the producer’s 
address.)

5 Select the Enable box to activate the product.

6 In the Product Itemization block, enter the following information: 

In this field: Do this:

Itemization Select the itemization type (required).
Sort Enter the sort order (required).
Pos (+) Select for a positive number.
Neg (-) Select for a negative number.

Note: The Pos and Neg buttons determine whether the 
values will increase or decrease the itemization total for 
the lease based on the selected lease product. Together 
the contents of the Product Itemization block, positive 
and negative, add up to the lease amount.

7 Select the Enabled box to indicate that this product itemization is currently available.

8 Save your entry.
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Scoring tab (Scoring Models page)
The Scoring Models page allows you to setup individual and multiple scoring models. You 
can define different scoring models by company, branch and product. Scoring models are 
used to automate the decisioning process on the Underwriting form and grade applica-
tions.

When you choose Next Application on the Application Entry form after entering an appli-
cation, Oracle Daybreak determines which scoring model to use by finding a best match. 
Oracle Daybreak searches the Company, Branch, and Product fields of all enabled scoring 
models that contain either the exact value on the application or ALL. (Exact matches for 
each field are given a higher weight than matches to ALL.) Oracle Daybreak then ranks the 
returned matches in descending order based on the weighted values and the hierarchical 
position of the field, then by Start Date. Oracle Daybreak recognizes the first row returned 
as the best match. This scoring model information is then used to determine the next status 
and sub status of the application.

If you use a standard bureau score as a scoring model, you can set up Oracle Daybreak to 
use the adverse action reasons provided by the standard bureau score on the Stipulations 
sub page.

To set up the Scoring Models page

1 On the Setup menu, choose Products > Lease.

2 Choose the Scoring tab, then choose the Scoring Models tab.

3 On the Scoring Models page, complete the following fields:

In this field: Do this:

Model Enter the code for the scoring model (required).
Description Enter a description of the scoring model (required).
Max Score Enter the maximum score allowed. (This is normally the 

sum of the Max Value fields within the scoring parame-
ters.) (required).

Company Select the company for the scoring model. This may be 
ALL or a specific company [PTC_COMPANY] (required).
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Branch Select branch within the company for the scoring model. 
This may be ALL or a specific branch [PCB_BRANCH]. 
This must be ALL if in the Company field you selected 
ALL) (required).

Product Select the product for the scoring model. This may be 
ALL or a specific product (Setup > Product >Lease > 
Products) (required).

Start Dt Enter the start date for the scoring model (required).
End Dt Enter the end date for the scoring model (required).

4 Select the Bureau Score Reasons box to use the score reasons supplied by the credit 
bureau. If not selected, automatically rejected applications scored using this scoring model 
display the Adverse Action Reasons from the Parameters sub page.

5 Select the Auto Decision box to assign an application a status/sub status based on the 
grade associated with the score returned for this scoring model. If not selected, Oracle 
Daybreak assigns applications scored using this scoring model a status/sub status of NEW-
REVIEW REQUIRED.

6 Select the Enabled box to enable the scoring model.

7 Save your entry.

Parameters sub page
The Parameters sub page records the parameters used to determine the score calculated by 
the scoring model. You can define multiple parameters and adverse action reason associ-
ated with each parameter in a scoring model. Each scoring parameter can have maximum 
values set. The score range is based upon the information in the Range Definition block on 
the Parameters sub page. 

Oracle Daybreak calculates a final score by adding the score for each parameter in the 
scoring model. A parameter weighted value is used to find the four adverse action reasons, 
if bureau reasons are not used.

Note: A character parameter range definition should contain the exact value of the param-
eter.

If the scoring parameter and range definitions were defined as below, then:

If the Value returned was: Then:

>= 0   & < 1000 Calculated values in this range would be translated into 
0% of the Max Value (in this case 1000) for this parame-
ter, which is 0.

>= 1000 & < 3000 Calculated values in this range would be translated into 
25% of the calculated value for this parameter. A param-
eter value of 1000 would result in a final value of 250. A 
parameter value of 2999 would result in a final value of 
749.75.
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>= 3000 & < 5000 Calculated values in this range would be translated into 
50% of the calculated value for this parameter. A param-
eter value of 3000 would result in a final value of 1500. 
A parameter value of 4999 would result in a final value 
of 2499.5.

>= 5000 & < 10000 Calculated values in this range would be translated into 
75% of the calculated value for this parameter. A param-
eter value of 5000 would result in a final value of 3750. 
A parameter value of 9999 would result in a final value 
of 7499.25.

>= 1000 Calculated values in this range would be translated into 
100% of the calculated value for this parameter. This 
would return the calculated value.

Note: Each scoring parameter should have range definitions defined that encompass all of 
the values that might result.

To set up the Parameters sub page for the auto-decisioning process

1 On the Setup menu, choose Products > Lease.

2 Choose the Scoring tab, then choose the Parameters sub tab.

3 In the Parameters block, enter the following information:

In this field: Do this:

Parameter Select the parameter from the LOV (required).
Max Value Enter the maximum value allowed for the selected 

parameter (required).
Adverse Action Reason Select the adverse action reason from the LOV 

[ADV_ACTION_APP_REASON_CD]. (If, on the Scoring 
Models page, the Bureau Screen Reasons box is selected 
for the scoring model, you cannot update this field) 
(optional).

Weighted Value Enter the adverse action weighted value. This indicates 
the priority of this parameter when determining which 
adverse action reasons to use on the application. The top 
ten adverse action reasons based on the weighted value of 
the parameter will be populated (required).

4 The Range Definition block allows you to translate the calculated value for a scoring 
parameter into the value to be used, depending on the returned value of the parameter.

In the Range Definition block, use the Value From field to enter the lowest calculated 
value to apply the specific translation. The ceiling of the range definition is based on the 
range definition with the next highest Value From or the Max Value of the scoring param-
eter (which ever is less) (required).
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5 Choose one of these options to determine how values for a scoring parameters are trans-
lated:

If you choose: Then:

% Max Value Calculated values within the range definition receives a 
value based on a percentage of the Max Value of the scor-
ing parameter.

% Param Calculated values within the range definition receives a 
value based on a percentage of the calculated value of the 
scoring parameter.

 Value Calculated values with in the range definition receives a 
specific value.

6 In the Percent / Value field, enter the percent or value to be used in the translation of the 
calculated value of the scoring parameter.

7 If you select the Enabled box, Oracle Daybreak will consider this range definition when 
translating values for this scoring parameter.

8 Save your entry.

Grades sub page
The Grades sub page defines how Oracle Daybreak translates the scoring model scores 
into your organization’s grade. Oracle Daybreak uses these grades in the auto-decisioning 
process. Each grade has a specific status/sub status that informs Oracle Daybreak what to 
do with the application of a particular grade as it continues through the origination cycle.

Note: Each scoring model should have grade definitions defined that encompass all of the 
values that might result.

To set up the Grades sub page for the auto-decisioning process

1 On the Setup menu, choose Products > Lease.

2 Choose the Scoring tab, then choose the Grades sub tab.
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3 In the Grade Definition block, enter the following information:

In this field: Do this:

Score Enter the score the application receives (required).
Credit Grade Select the grade to assign to an application 

[CR_GRADE_CD] (required).
Application Status Select the status to assign to applications with a score 

starting with the value of this grade definition 
[APP_STATUS_CD_AUTO] (required).

Sub Status Select the sub status to assign to applications with a score 
starting with the value of this grade definition.
Credit scoring only allows for only the following status/
sub status pairs:
APPROVED - AUTO APPROVED
REJECTED - AUTO REJECTED
NEW - REVIEW REQUIRED
NEW - RECOMMEND APPROVAL
NEW - RECOMMEND REJECTION
[APP_SUB_STATUS_CD]
(required).

4 Select Enabled to indicate that this grade definition will be considered when grading an 
application using this scoring model.

5 Save your entry.
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Scoring tab (Behavioral Scoring Models page)
Behavior scoring examines the repayment trends during the life of the account and pro-
vides a current analysis of the customer. This logical and systematic method identifies 
which accounts are more likely to perform favorably versus accounts where poorer perfor-
mance is probable. This is useful when determining which other lease products a customer 
may qualify for. 

This information appears on the Customer Service form in the Customer Service (2) 
master tab’s Account Details page in the Activity block’s Behavior Score field.

The Behavioral Scoring Models page allows you to setup individual and multiple behavior 
scoring models. Completing the Behavioral Scoring Models page is similar to completing 
the existing Scoring Parameters page, although new parameters have been added for 
behavioral scoring. You can define multiple behavior scoring models and depending upon 
the market situation and customer account behavior, enable only the models you want 
Oracle Daybreak to use.

Oracle Daybreak calculates behavior scores in a manner similar to how it calculates the 
Oracle Daybreak credit score during lease origination.

Oracle Daybreak behavior scoring applies to accounts and is based on account history 
attributes and performed on a monthly basis. 
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To set up the Behavioral Scoring Models page

1 On the Setup menu, choose Products > Lease.

2 Choose the Scoring tab.

3 On the Behavioral Scoring Models page, complete the following fields:

In this field: Do this:

Model Enter the model for the behavior score (required).
Description Enter the description of the model (required).
Max Score Enter the maximum score value for the behavior score. 

(This is normally the sum of the Max Value fields within 
the scoring parameters.) (required).

Company Select the company which uses this behavior score. This 
may be ALL or a specific company [PTC_COMPANY] 
(required

Branch Select the branch corresponding to the company. This 
may be ALL or a specific branch [PCB_BRANCH]. This 
must be ALL if in the Company field you selected ALL) 
(required).

Product Enter the product to which the behavior score applies. 
This may be ALL or a specific product (Setup > Product 
> Lease > Products) (required).

Start Date Enter the start date for the behavior scoring model 
(required).

End Date Enter the end date for the behavior scoring model 
(required).

 
4 Select the Enabled box to enable the behavior scoring model.

5 Save your entry
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Parameters sub page
The Parameters sub page records the parameters used to determine the score calculated by 
the behavior scoring model. The score behavior range is based upon the information in the 
Range Definition block on the Parameters sub page. 

Oracle Daybreak calculates a final score by adding the score for each parameter in the 
scoring model. A parameter weighted value is used to find the four adverse action reasons, 
if bureau reasons are not used.

Note: A character parameter range definition should contain the exact value of the param-
eter.

If the behavior scoring parameter and range definitions were defined as in the example 
above, then:

If the Value returned was: Then:

>= 0   & < 30 If the account was delinquent between 0 and 29 days, the 
behavior scoring model value would be 0.

>= 30 & < 60 If the account was delinquent between 30 and 59 days, 
the behavior scoring model value would be 200.

>= 60 & < 90 If the account was delinquent between 60 and 89 days, 
the behavior scoring model value would be 300.

>= 90 If the account was delinquent over 90 days, the behavior 
scoring model value would be 400.

Note: Each scoring parameter should have range definitions defined that encompass all of 
the values that might result.
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To set up the Parameters sub page for behavior scores

1 On the Setup menu, choose Products > Loan.

2 Choose the Scoring tab, then choose the Behavioral Scoring Models tab.

3 Choose the Parameters sub tab.

4 In the Parameters block on the Parameters sub page, enter the following information:

In this field: Do this:

Parameter Select the parameter from the LOV (required).
Max Value Enter the maximum value allowed for the selected 

parameter (required).
Enabled Select to enable the parameter.

5 The Range Definition block allows you to translate the calculated value for a behavior 
scoring parameter into the value to be used, depending on the returned value of the param-
eter.

In the Range Definition block, use the Value From field to enter the lowest calculated 
value to apply the specific translation. The ceiling of the range definition is based on the 
range definition with the next highest Value From or the Max Value of the behavior scor-
ing parameter (which ever is less) (required).

6 Choose one of these options to determine how values for a behavior scoring parameter are 
translated:

If you choose: Then:

% Max Value Calculated values within the range definition receives a 
value based on a percentage of the Max Value of the 
behavior scoring parameter.

% Param Calculated values within the range definition receives a 
value based on a percentage of the calculated value of the 
behavior scoring parameter.

 Value Calculated values with in the range definition receives a 
specific value.

7 In the Percent / Value field, enter the percent or value to be used in the translation of the 
calculated value of the behavior scoring parameter.

8 If you select the Enabled box, Oracle Daybreak will consider this range definition when 
translating values for this behavior scoring parameter.

9 Save your entry.
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Contract tab (Lease Contract page)
The Lease Contract page allows you to define the loan instruments used within your Ora-
cle Daybreak system. A loan instrument is a contract used by a financial organization with 
specific rules tied to it. When processing an application, an instrument associated with the 
application informs Oracle Daybreak of the type of contract being used for the approved 
lease. This ensures that all parameters tied to the instrument are setup for the account as it 
is booked - without requiring you to do it.

Items defined in the contract are “locked in” when you choose Select Instrument on the 
Funding form’s Contract (5) page. These values cannot be changed on the Customer Ser-
vice form’s Contract (5) master tab after the lease has been booked and funded.

The Contract Definition block’s Instrument and Description fields allow you to enter the 
financial instrument’s name and description, for example; INS-: VEHICLE - FIXED RATE.

Instruments can be setup at different levels:

• Company
• Branch
• Product
• Application state

The following groups of parameters are setup at the instrument level (Each has its own 
block on the Lease Contract block):

• Accrual
• Other
• Billing
• Extensions
• Scheduled dues
• Delinquency
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To set up the Contract page

1 On the Setup menu, choose Products > Lease.

2 Choose the Contract tab, then choose the Lease Contract tab.

3 In the Contract Definition block, enter the following information:

In this field: Do this:

Instrument Enter the code identifying the loan instrument (required).
Description Enter the description of the loan instrument being 

defined.
Company Select the company for the loan instrument. This may be 

ALL or a specific company (Setup > Administration > 
User > Companies) (required).

Branch Select the branch within the company for the loan instru-
ment. This may be ALL or a specific branch (Setup > 
Administration > User > Companies). This must be 
ALL if in the Company field you selected ALL) 
(required).

Billing Cycle Select the billing cycle selected [_BILL_CYCLE_CD] 
(required).

Product Select the product for the loan instrument. This may be 
ALL or a specific product (required). 

State Select the state in which the loan instrument is used. This 
may be ALL or a specific state [STATE_CD] (required).

Start Dt Enter the start date for the loan instrument (required).
End Dt Enter the end date for the loan instrument (required).

IMPORTANT: In selecting which lease type to use, Ora-
cle Daybreak searches for a best match using the follow-
ing attributes:

1 Billing Cycle
2 Start Date
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3 Company
4 Branch
5 Product
6 State

For this reason, i-flex solutions recommends creating one 
version of each lease type where ALL is the value in these 
fields.

4 Choose Enabled and Oracle Daybreak will consider this contract definition when select-
ing a loan instrument for an application.

5 In the Billing block, enter the following information:

In this field: Do this:

Billing Type Select the billing type [LEASE_BILL_TYPE_CD] 
(required).

Billing Mthd Select the billing method [LEASE_BILL_TYPE_CD] 
(required).

Prebill Days Enter the pre bill days (required).
Spread Select the default payment spread (required).

6 In the Other block, enter the following information:

In this field: Do this:

Lease Type Select the lease type [LEASE_TYPE_CD] (required).
Refund Tolerance Enter the refund tolerance amount (required).
Pmt Tolerance Enter the payment tolerance amount (required).
% Enter the payment tolerance percentage (required).
Writeoff Tolerance Amt Enter the writeoff tolerance amount (required).
Refund Allowed Select this check box if refunds are allowed for this lease 

instrument (required).
Int Amortization Freq Select the interest amortization frequency: 

DAILY
-or-
MONTHLY (MONTHS END)
[AMORTIZE_FREQ_CD] (required).

7 In the Scheduled Dues block, enter the following information:

In this field: Do this:

Max Due Day Chg Days Enter the maximum days allowed (required). 
Due Day Min Enter the minimum due day allowed (required).
(Due Day) Max Enter the maximum due day allowed (required).
Max # Due Day Changes - Enter the maximum number of due day changes allowed
Year in a year (required).
(Max # Due Day Changes) Enter the maximum number of due day changes allowed
Life in the life of the lease (required).

8 In the Tax block, enter the following information:

In this field: Do this:

Sales Tax Mode Select the sales tax mode [SALES_TAX_METHOD_CD] 
(required).
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Sales Tax Mthd Select the sales tax method [SALES_TAX_METHOD_CD] 
(required).

9 In the Delinquency block, enter the following information to define how delinquencies 
are handled for leases using this loan instrument. 

In this field: Do this:

Late Charge Grace Days Enter the number of grace days allowed for the payment 
of a due date before a late charge is assessed on the 
account (required).

Delq Grace Days Enter the number of grace days allowed for the payment 
of a due date before an account is considered delinquent. 
This affects DELQ Queues, Oracle Daybreak reporting, 
and the generation of collection letters (required).

Delq Category Method Select the delinquency category method to determine the 
how Oracle Daybreak populates delinquency counters on 
the Customer Service form. Note: This value does not 
affect credit bureau reporting 
[DLQ_CATEGORY_METHOD_CD] (required).

10 Save your entry.
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Balances sub page
The Balances sub page lists the balances that will be established when an account is 
booked and funded. 

CAUTION:
Please contact your Implementation Manager for changes to this section. 

To set up the Balances sub page

1 On the Setup menu, choose Products > Lease.

2 Choose the Contract tab, then choose the Lease Contract tab.

3 Choose the Balance sub tab.

4 Complete the Contract Balances block with the following information:

In this field: Do this:

Balance Type View the transaction/balance type [TXN_TYPE_CD] (dis-
play only).

Chargeoff Method Select the charge off method to determine how the out-
standing amount of this balance type will be handled if 
the account becomes uncollectable and the lease is 
charged off [CHARGEOFF_METHOD_CD] (required).

Writeoff Method Select the write off method to determine how the out-
standing amount of this balance type will be handled if 
the account is within the write off tolerance of being 
PAID [WRITEOFFF_METHOD_CD] (required).

Reschedule Method Select the reschedule method to determine how the out-
standing amount of this balance type will be handled if 
the account is rescheduled 
[RESCHEDULE_METHOD_CD] (required).
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Sort Enter the sort order of how account balances will appear 
on the Customer Service form’s Balance page (required).

5 If the balance can be billed, select the Billed box. This indicates that outstanding amounts 
for this balance type are considered a part of the billed amount. This also determines 
whether payments applied to this balance type are considered when satisfying outstanding 
amounts due.

6 If the interest is accrued on the balance type, select the Accrued box. This indicates that 
outstanding amounts for this balance type will be included when interest is accrued against 
the account.

7 The Non-Performing Rollover box does not apply to leases and is dormant.

8 The Non-Performing Balance Type field does not apply to leases and will contain the 
default entry of NONE.

9 Select the Enabled box to indicate that this balance type will be created when the account 
is booked and funded.

When defining a balance type, you must choose the Load Balances button. Once the bal-
ance definitions have been loaded, you may update entries on Contract Balance block, but 
you may not load them again. 

10 Choose Load Balances.

Oracle Daybreak loads the currently defined balances for accounts. 

Amortize Balances sub page
With the Amortize Balances sub page, you can select one or more balances to be amor-
tized over the life of the lease. You can also define the amortization method. 

Note: Interest is automatically amortized, so there is no need to manually set it up.

To set up the Amortize Balances sub page

1 On the Setup menu, choose Products > Lease.

2 Choose the Contract tab, then choose the Lease Contract tab.
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3 Choose the Amortize Balances sub tab.

4 Complete the Amortization Balances block with the following information:

In this field: Do this:

Amortize Balance Type Select the amortize transaction type 
[AMORTIZE_TXN_TYPE_CD] (required).

Amortization Method Select the amortization method used to calculate the net 
amortization amount [AMORTIZE_CALC_METHOD_CD] 
(required).

Cost/Fee Method Select the amortization fee method 
[AMORTIZE_FEE_METHOD_CD] (required).

Sort Enter the sort sequence to define the order of the amor-
tize balances (required).

5 Select Enabled to enable the amortize balance to be created when the account is booked 
and funded.

6 Save your entry.

Itemization sub page
On the Itemization sub page, you can define the itemized components for each type of 
contract, indicate if it is required, and determine whether it has a positive or negative bear-
ing on the contract itemization math. You can establish the following groups of itemiza-
tion transactions:

Advance Total amount of the line of credit that is not a part of financed 
fees; in other words, the total amount the customer requested to 
be advanced.

Financed Fees Finances Fees is not available for leases.
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Pre-paid Fees Fees that are paid by the consumer prior to the funding of the line 
of credit. These fees are not rolled into the balance of the line of 
credit but are considered as part of the finance charge and are 
included in the calculation of the APR.

Producer Fees that are paid to or by the producer of the line of credit; for 
example, a fee that is being charged to the producer. These trans-
actions will affect proceeds.

Escrow Escrow is not available for leases.

To set up the Itemization sub page

1 On the Setup menu, choose Products > Lease.

2 Choose the Contract tab, then choose the Lease Contract tab.

3 Choose the Itemization sub tab.

4 Choose the option button to indicate the type of itemization you are defining: Advance, 
Financed Fees, Pre-Paid Fees, Producer, or Escrow.

5 Complete the Contract Itemization block with the following information:

In this field: Do this:

Itemization Select the itemization type (required).
Transaction Select the funding transaction type (required).
Amortize Balance Select the amortize balance affected by this itemization 

transaction. Note: Advance itemizations do not affect 
amortize balances (required).

Refund Allowed Select to indicate refund is allowed for this itemization.
Refund Method Select refund calculation method (required).
Escrow Select the escrow (required).
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Required Escrow If this is an escrow account, select this box to signal an 
escrow is required during the application process (though 
at that time the user can choose Opt Out to decline.)

Sort Enter the sort order to define the order of the itemization 
transactions (required).

6 If the itemized transaction increases the group balance, choose Pos.
-or- 
If the itemized transaction decreases the group balance, choose Neg.

7 Select the Taxable box if the itemization type is taxable.

8 In the Itemization Formula field, select the itemization formula description (required).

9 In the Itemization Type field, select the itemization (required).

10 In the Disc. Rate field, enter the discount rate for the itemization (optional).

11 Select Enabled to enable the itemization and indicate that this itemization transaction will 
be created when the account is booked and funded.

12 Save your entry.

Fees sub page
Any fees that are defined in the contract are set up on the Fees sub page. Oracle Daybreak 
currently supports the following contract fees:

• Late charges
• Non sufficient funds
• Extensions

The Fees sub page allows you to define those fees whose value and method of calculation 
are set at the time of the lease. As these amounts cannot be change after the lease is 
booked and funded, you should only set up fees here that will not change over the life of 
the lease. Individual contract fee types may be defined multiple times in order to create 
graduated fees.

Note: Certain fees, like late fees, can be set up at contract, as well as state level. In such 
cases, the contract fee, if present, is used first.

Assume the above contract fee definitions are a part of the same loan instrument.

If the outstanding 
Transaction Amount was: Then:

>= $0.00 & < $500.00 Oracle Daybreak would assess a fee of $10.00 when a 
payment was not received within the late charge grace 
days of the due date.

>= $500.00 & < $1000.00 Oracle Daybreak would assess a fee of between $10.00 
and $30.00 based on 5.5% of the outstanding payment 
amount when a payment was not received within the late 
charge grace days of the due date.
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>= $1000.00 Oracle Daybreak would assess a fee between $35.00 and 
$150.00 based on 4.5% of the outstanding payment 
amount when a payment was not received within the late 
charge grace days of the due date.

To set up the Fee sub page

1 On the Setup menu, choose Products >Lease.

2 Choose the Contract tab, then choose the Lease Contract tab.

3 Choose the Fees sub tab.

4 Complete the Contract Fees block with the following information:

In this field: Do this:

Type Select the fee type (required).
Txn Amt From Enter the lowest transaction amount or balance amount 

against which this contract fee definition may be applied 
(required).

Method Select the method of calculating the fee to be assessed 
[FEE_CALC_METHOD_CD] (required).

Min Amount Enter the minimum fee amount to be assessed (required).

Max Amount Enter the maximum fee amount to be assessed. If you 
entered FLAT in the Method field, then this field is not 
used and is normally populated as $0.00 (required).

Percent Enter the fee percentage of the outstanding transaction 
amount to be assessed as a fee. This amount will be 
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adjusted to fall within the Min Amount and the Max 
Amount.

5 Select Enabled and this contract fee will be created when the account is booked and 
funded.

6 Save your entry.
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Fees tab (Fee page)
The Fee page allows you to define fees that may be automatically assessed by Oracle Day-
break. The Fee Definitions block records fees not defined within the Contract page’s Fees 
sub page.

The following fee types are currently supported for automatic assessment:

• Late charges
• Non sufficient funds
• Extensions

Fees can be calculated as either a flat amount or a percentage of payment due based on fee 
type.

You can specify minimums and maximums for fee amounts in the Min Amt and Max Amt 
fields. Different fee rules can be setup at the company/branch level. 

When Fees are assessed, Oracle Daybreak determines the best match using all enabled fee 
definitions for that meet the following criteria:

• Exactly match the fee type being assessed.
• Have an effective date that is greater than or equal to the start date.
• Have a Txn Amt From that is greater than or equal to the outstanding amount related 

to the fee assessment.
• Match either the value or ALL for all other criteria (Exact matches for each field are 

given a higher weight than matches to ALL.)

The returned rows are then given a descending rank based on the weighted values and the 
hierarchical position of the following criteria:

1 Company
2 Branch
3 Product
4 Account state
5 Transaction amountt
6 Start Date.

On the ranked rows - the first row is returned as the best match.

Note: Certain fees, like late fees, can be set up at contract, as well as state level. In such 
cases, the contract fee, if present, is used first. Only if the contract fee is not present is the 
state fee used.
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To set up the Fees page

1 On the Setup menu, choose Products > Lease.

2 Choose the Fees tab.

3 The Fee Definition block defines the individual fees. Complete the Fee Definition block 
with the following information:

In this field: Do this:

Fee Rule Enter the fee rule used to identify the particular fee defi-
nition (required).

Fee Type Select the fee type (required).
Calc Method Select the method of calculating the fee 

[FEE_CALC_METHOD_CD] (required).
Min Amt Enter the minimum amount for the fee (required).
Max Amt Enter the maximum amount for the fee. If you selected 

FLAT AMOUNT in the Calc Method field, then this field 
is not used and is normally populated as $0.00 (required).

Percent Enter the percentage value of the outstanding transaction 
amount to be assessed as a fee. This amount will be 
adjusted to fall within the Min Amount and the Max 
Amount (required).

Company Select the portfolio company. This may be ALL or a spe-
cific company (Setup > Administration > User > Com-
panies) (required).

Branch Select the portfolio branch. This may be ALL or a spe-
cific branch (Setup > Administration > User > Compa-
nies). This must be ALL if in the Company field you 
selected ALL) (required).

Product Select the product. This may be ALL or a specific prod-
uct. The available values come from a validated LOV 
based on the selected Billing Cycle setup and the Lease 
Product setup (required).

State Select the state for this fee. This may be ALL or a specific 
state [STATE_CD] (required).

Txn Amt From Enter the transaction or balance amount. The fee is calcu-
lated using the specifications of this record only if the 
transaction amount is greater than the value specified in 
this field (and less than this field in another record for the 
same fee) (required).

Start Dt Enter the start date (required).
End Dt Enter the end date (required).
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IMPORTANT: In selecting which fee to use, Oracle Day-
break searches for a best match using the following 
attributes:

1 Company
2 Branch
3 Product
4 State
5 Amount (Txn Amt From)
6 Effective/start date (Start Dt)

For this reason, i-flex solutions recommends creating one 
version of each fee where ALL is the value in the these 
fields.

It is also recommended that you define a default printer 
for an Organization, Division and Department.

4 Select Enabled to enable the fee.

5 Save your entry.

Checklists tab (Checklists page)
A checklist is an optional set of steps to follow when completing a form in Oracle Day-
break, such as the Underwriting form, the Funding form, or completing a page involving 
collections on the Customer Service form. Checklists can be used as guidelines to help 
ensure that Oracle Daybreak users follow your business’s standard operating procedures 
and enter all required data. Some checklists are optional, but others such as those related to 
application decisions or contract verification, may be required depending on the edit sets 
defined in your Oracle Daybreak system. Checklists page allows you to specify the con-
tents of the checklist.

The following checklists are built in to the origination workflow and can be viewed when 
edits are checked:

• DECISION VERIFICATION CHECKLIST.
• CONTRACT VERIFICATION CHECKLIST.

The following checklists are built in to the Customer Service form and can be viewed dur-
ing collection tasks:

• BANKRUPTCY CHECKLIST
• CHARGE-OFF CHECKLIST 
• REPOSSESSION/FORECLOSURE CHECKLIST 

You can define additional checklists for your organization. You can set up multiple check-
lists for a single type of checklist. These checklists can be differentiated by:

• Company 
• Branch
• Product
• Account state
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To set up the Lease Checklist page

1 On the Setup menu, choose Products > Lease.

2 Choose the Checklists tab.

3 Complete the Checklist Type Definition block with the following information:

In this field: Do this:

Checklist Code Enter the checklist code that identifies checklist being 
defined (required).

Description Enter the description for the checklist (required).
Checklist Type Select the checklist type to define where the specific 

checklist will be available in Oracle Daybreak 
[CHECKLIST_TYPE_CD] (required).

Company Select the portfolio company associated with the check-
list. This may be ALL or a specific company (Setup > 
Administration > User > Companies) (required).

Branch Select the portfolio branch associated with the checklist. 
This may be ALL or a specific branch (Setup > Adminis-
tration > User > Companies). This must be ALL if in the 
Company field you selected ALL) (required).

Product Select the product associated with the checklist. This may 
be ALL or a specific product. The available values come 
from a validated LOV based on the selected Billing 
Cycle setup and the Lease Product setup (required).

State Select the state associated with the checklist type. This 
may be ALL or a specific state [STATE_CD] (required).

IMPORTANT: In selecting which edits type to use, Ora-
cle Daybreak searches for a best match using the follow-
ing attributes:

1 Company
2 Branch
3 Product
4 State
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For this reason, Daybreak recommends creating one ver-
sion of each checklist type where ALL is the value in 
these fields.

Enabled Select to enable the checklist.

4 Checklist actions are steps (a set of one or more tasks) related to the checklist you are cre-
ating. They are loaded on the Checklist sub page.

Complete the Checklist Action Definition block with the following information:

In this field: Do this:

Action Code Enter the action code for the checklist (required).
Description Enter the description for the action type (required).
Sort Enter the sort order to define the placement of the action 

type on the Checklist sub page (required).

5 Select Enabled to include this action in the checklist.

6 Save your entry.
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Spreads tab (Spreads page)
The Spreads page allows you to define the payment allocation strategy used by your busi-
ness while applying payments to accounts. Spreads are selected on the Payment Entry 
(and Payment Maintenance) pages. The payment to the account according to the spread 
can be viewed on the Transaction page on the Customer Service form.

The Spread Definition block is used to define individual spreads. Many common spreads 
have already been defined. With each spread, you can define the due date advancement 
method to use, BRING CURRENT, FUTURE, or NONE.

The Spread Transaction Definitions block records the order in which balances are satisfied 
when a payment is applied to an account. (Unless someone indicates otherwise, payments 
will be applied against each balance type, in sort order, until either there is no remaining 
balance, or the payment has been completely allocated.) 

To open the Spreads page

1 On the Setup menu, choose Products > Lease.

2 Choose the Spreads tab.

3 In the Spread Definition block, enter the following information:

In this field: Do this:

Spread Enter the code identifying the spread (required).
Description Enter the description for the spread. (This usually reflects 

when this spread is used.) (required).
Due Dt Adv Select the due date advancement code that determines 

how payments applied using this spread will affect due 
amounts. Oracle Daybreak uses the following predefined 
Due Dt Adv Codes:
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BRING CURRENT - The payment allocations for transac-
tions against an account’s outstanding balances that make 
up the billed balances. This will be applied against billed 
due amounts.
FUTURE - The payment allocations for transactions 
against an accounts outstanding balances that make up 
the billed balances. This will be applied against billed 
due amounts. Any remaining amount allocated against 
billed balances will be accumulated and applied against 
future due amounts. [DUE_DT_ADVANCEMENT_CD] 
(required).
NONE - Payments applied using this spread will not 
affect the due amounts of the account in any way.

Enabled Select box to enable the spread.

4 In the Spread Transaction Definition block, enter the following information:

In this field: Do this:

Balance Type Select the balance type to allocate a portion of the 
received payment against (required).

Note: i-flex solutions recommends that you always setup 
an ADVANCE/PRINCIPAL balance type for each spread.

Cycle (Line of credit only) Enter the balance cycle during 
which to apply payments. This collects payment on bad 
(unpaid) cycles. You can only go back five cycles. Cycle 
will have a value of 0 for s (required).

Sort Enter the sort order in which the balance type has pay-
ments allocated against it (required).

5 Select Enabled and Oracle Daybreak will consider this spread transaction when allocating 
payments. 

6 Choose Load Details.

Oracle Daybreak loads the spread transaction definitions for newly created spread defini-
tions to ensures that all balance types related to payment allocation will be included in a 
spread.

7 Save your entry.
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Statement tab (Messages page)
The Messages page allows you to set up messages that appear on account statements sent 
to customers. You can set up statement messages for different products. When Oracle 
Daybreak generates a statement for an account, all statement messages matching the selec-
tion criteria are included in the statement file for that account. 

Oracle Daybreak inserts the message in the Text field into the statement file produced dur-
ing the nightly batch job for the appropriate consumers. 

A record of an account’s statement history, including the messages included in the state-
ment, appears on the Statements page on the Customer Service form.

To set up the Statements (Messages) page

1 On the Setup menu, choose Products > Lease.

2 Choose the Statement tab.

3 In the Statement Messages block on the Messages page, enter the following informa-
tion:

In this field: Do this:

Seq Enter the sort sequence of how the statement message 
should be printed (required).

Code Enter the message code identifying the statement mes-
sage (required).

Text Enter the text of the statement message (required).
Company Select the company for the statement message. This may 

be ALL or a specific company (Setup > Administration 
> User > Companies) (required).

Branch Select the branch within the company for the statement 
message. This may be ALL or a specific branch (Setup > 
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Administration > User > Companies). This must be 
ALL if in the Company field you selected ALL (required).

Product Select the product for which this statement message will 
be used. This may be ALL or a specific product 
(required).

IMPORTANT: In selecting which message to use, Oracle 
Daybreak searches for a best match using the following 
attributes:

1 Company
2 Branch
3 Product
4 Producer

For this reason, i-flex solutions recommends creating one 
version of each edit type where ALL is the value in these 
fields.

Producer Select the producer for the statement message. This may 
be ALL or a specific producer. The available values come 
from a validated LOV based on the Pro Group and Pro 
Type (required).

Start Dt Enter the first date the statement message is available 
(required).

End Dt Enter the last date the statement message is available 
(required).

4 Select Enabled to enable the message.

5 Save your entry.
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Letters tab (Letters page)
The Letters page allows you to define letters that Oracle Daybreak automatically generates 
when the account meets certain conditions, or “trigger events.” Each letter has its own 
trigger event. For example, you can configure Oracle Daybreak to automatically send a 
welcome letter when an application becomes an account or send a collection letters when 
an account becomes delinquent. 

Oracle Daybreak supports the following types of letters:

Type of letter: Definition:

COLLECTION LETTER 1 Generated when an account becomes delinquent. This is 
the first dunning letter sent to the customer.

COLLECTION LETTER 2 Generated when an account remains in delinquency for 
an extended period. This is the second dunning letter sent 
to the customer.

COLLECTION LETTER 3 Generated when an account remains in delinquency for 
an extended period, even after having received previous 
notices. This is the final dunning letter sent to the cus

ACCOUNT STATEMENT Generated when account is to receive a billing statement 
(this time is defined in contract setup). Letter is sent to 
customer.

When Oracle Daybreak generates letters, it searches the Letters page for letter definitions 
that meet the following criteria:

• Definition is enabled.
• Definition is an exact match of the letter code being generated.
• Definition is a match of either the account value or ALL for all other criteria.

Exact matches for each field are given a higher weight than matches to ALL.

The returned rows are then given a descending rank based on the weighted values and the 
hierarchical position of these fields:

1 Company
2 Branch
3 Product
4 State
5 Channel

On the ranked rows, the first row is returned as the best match.
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To set up the Letters page

1 On the Setup menu, choose Products > Lease.

2 Choose the Letters tab.

3 In the Letters Definition block on the Lease Letters page, enter the following informa-
tion:

In this field: Do this:

Letter Code Enter the code for the letter (required).
File Name Enter the file name of the Oracle report used to generate 

the letter. The file should be named <File Name>.rep on 
your server (required).

Batch Printer Select the batch printer being used to generate the letter 
(Setup > Administration > User > Printers) (required).

Batch User Select the Oracle Daybreak user who will submit this let-
ter. This will normally be set to BATCH (Setup > Admin-
istration > User > Users) (required).

Letter Type Select the type of letter you want to generate 
[CORRESPONDENCE_TYPE_CD] (required).

Company Select the portfolio company for which this letter will be 
used. This may be ALL or a specific company (Setup > 
Administration > User > Companies) (required).

Branch Select the portfolio branch for which this letter will be 
used. This may be ALL or a specific branch (Setup > 
Administration > User > Companies). This must be 
ALL if in the Company field you selected ALL) 
(required).

Product Select the product for which this letter will be used. This 
may be ALL or a specific product (required).

State Select the state for which this letter will be used. This 
may be ALL or a specific state [STATE_CD] (required).

Channel Select the application source (channel) for the letter. This 
may be ALL or a specific channel [APP_SOURCE_CD] 
(required).

4 Select Enabled to enable this letter definition.

5 Save your entry.
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CHAPTER 5 : QUEUE SETUP FORM

When processing an application, various Oracle Daybreak users might work on the appli-
cation to complete different tasks. A data entry person might complete the Application 
Entry form before an underwriter works on the application using the Underwriting form. 
Later, another Oracle Daybreak user might work on the application using the Funding 
form. 

The application processing workflow facilitates the movement of the application from one 
person to another with queues. Queues create a work list of accounts waiting for a particu-
lar and common task to be performed, such as application entry or verification. Oracle 
Daybreak’s powerful queuing module automates this otherwise manual process. The 
Queue Setup form allows you to manage workflow and work assignments on a daily basis 
and ensure that all applications are in the queues of the appropriate users at all times. Any 
time an application’s status is changed, Oracle Daybreak checks whether the application is 
in the right queue. 

Oracle Daybreak will sort queues based on an account’s status and condition. A condition 
is the state of an account at a particular time, such as a delinquent, which determines what 
Oracle Daybreak user needs to take action.

Oracle Daybreak distinguishes between two types of queues: Origination Queues and Cus-
tomer Service Queues.

Origination Queues
The Origination page on the Queue Setup form allows you to set up queues that direct 
applications to Oracle Daybreak users during the lease origination cycle. Whenever an 
application changes its status/sub status, the Oracle Daybreak moves the application to a 
queue based on the information on this page.

You can define the lease origination queues and the corresponding selection criteria based 
on:

• Product type
• Funding type
• Product
• Underwriter
• State
• Channel
• Producer type
• Producer

With lease origination queues set up, the applications in your work queue automatically 
appear on the Results page when you open the Underwriting or Funding form. The queue 
to which you are assigned appears in the Queue Name field. You would then begin pro-
cessing the applications in the order of which they are listed, double-clicking the applica-
tion at the top of the list to load it. 
Chapter 5 :-1  Setup Guide - Consumer Lease Collection



Customer service queues
On the Customer Service form, queues create a work list of accounts waiting for a particu-
lar and common task to be performed, such as collecting on a delinquency. Oracle Day-
break’s powerful queuing module automates this otherwise manual process. The Queue 
Setup form allows you to manage workflow and work assignments and ensure that all 
accounts are in the queues of the appropriate users at all times. 

Note: The User Productivity form allows you to view the number of applications in a 
queue.

Customer Service queues distribute and route accounts that require some particular action 
to be performed to specific Oracle Daybreak users or departments. Oracle Daybreak sorts 
customer service queues based on an account’s status and condition. A condition is the 
state of an account at a particular time, such as DELINQUENT, which determines which 
Oracle Daybreak user needs to take action. 

Accounts become available for queue assignment when an account receives a condition. 
Conditions can be applied automatically by Oracle Daybreak or manually by users. For 
example, during nightly processing, Oracle Daybreak recognizes an account as delinquent 
and automatically assigns it a condition of DELQ (“Delinquent”). Oracle Daybreak users 
can manually change an account’s condition using combination of Action and Result field 
entries on the Customer Service form’s Call Activities sub page. 

These Action and Result field entry combinations are set up on the Queue Setup form’s 
Action Results page.

Oracle Daybreak associates an account with one or more queue based on multiple parame-
ters, including user-defined criteria and the follow-up date. For example, customer service 
queues might be configured so accounts are parsed to users according to:

• Due date changes
• Deferment requests
• Title and insurance follow-up dates

Collections queues are included in the Customer Service queue. These queues focus on:

• General collections
• Bankruptcy
• Foreclosure
• Repossession
• Deficiency

Customer Service queues can be built online or in a nightly batch job. Within each queue, 
the order of the accounts can be sorted based on user-defined criteria.

Note: Although Oracle Daybreak allows you define your own selection criteria in creating 
queues, the system’s performance depends on how the selection criterion is defined. 

Note: You can use these same methods for creating and closing queues in the case of 
repossession, foreclosure, and deficiency.
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Setup tab (Action Results page)
The Action Results page allows you to define the contents of the Action and Result fields 
on the Customer Service form’s Call Activities sub page. Oracle Daybreak uses this infor-
mation to allow Oracle Daybreak users to manually change the condition of an account, 
and thus assign or remove the account to a queue. 

Depending on how you set up call action result codes on the Action Results page, condi-
tions and queues are created or closed. You can also restrict the use of certain call activi-
ties based on responsibility. 

The lookup type ACC_CONDITION_CD defines which account conditions can be created. 
The Oracle Daybreak queuing engine determines if queues need to be created based on the 
information in the Lookup Code block for this lookup type.

The following graphic displays the possible combinations of condition and queue.

(1) Condition: Open, Queue: Open 
• In this state, both the account condition and queue are created or opened at the same 

time. 
• The Oracle Daybreak transaction-processing engine automatically creates DELQ, TIP, 

SCHGOFF conditions and queues; therefore, don’t setup any call action result with 
these conditions.

• CHGOFF is an account status, so no queues are created. To follow-up on charged-off 
accounts, create DEFICIENCY condition with this option.

• BKRP (Bankruptcy), REPO (Repossession), FORC (Foreclosure) account conditions 
and queues can be opened with this option. Also, account level indicators (for report-
ing purposes) are set.

(2) Condition: Open, Queue: NA
• In this state, only the account condition is created or opened. 
• This option should only be used if no queuing is necessary on this account condition.

(3) Condition: NA, Queue: Close
• In this state, the queue associated to the account condition is closed.
• This option should only be used if an existing queue on this account condition should 

be closed; for example, accounts with bankruptcy condition no delinquency follow-up 
may be necessary. In such case, DELQ queue can be closed while the condition is still 
open.

• DELQ, TIP, SCHGOFF queues can be closed by using this option.

(4) Condition: Close, Queue: Close
• In this state, both the account condition and queue are closed.
• Oracle Daybreak transaction-processing engine automatically closes DELQ, TIP, 

SCHGOFF conditions and queues; therefore, don’t setup any call action result with 
these conditions. 
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• BKRP (Bankruptcy), REPO (Repossession), FORC (Foreclosure) account conditions 
and queues can be closed with this option. Also, account level indicators (for reporting 
purposes) are set. 

To set up the Action Results page

1 On the Setup menu, choose Queues > Setup.

2 In the Call Actions block, complete the following fields to define your call action codes 
and corresponding descriptions.

In this field: Do this:

Action Code Enter the action type code (required).
Description Enter the description for the call action type (required).
Call Type Select the call type (required).
Enabled Select to enable the call action.

3 In the Call Results block, complete the following fields to define call action result codes 
and corresponding descriptions:

In this field: Do this:

Result Code Enter the result type code for the call action type (chosen 
above) (required).

Description Enter the description for the result type (required).
Report Type Select the report type for the result type (required).
Right Person Contact Note: Currently there is no functionality associated with 

the Right Person Contact check box.
Follow-up Advance Unit Select the unit for advancing the follow-up date/time 

(required).
Value Enter the value for the follow-up advance unit (required).
Enabled Select to enable the result.

4 The Conditions block determines whether the selected action/result will cause the listed 
conditions will be opened or closed. It also determines whether the queue will be opened 
or closed.
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In the Conditions block, select the Condition (Open, Close or N/A) and Queue (Open, 
Close or N/A) button for each action-result combination.

In this field: Do this:

Condition Select the account condition to be open/close for the 
action (required).

Condition: Open/Close/NA Select the option.
Queue: Open/Close/NA Select the option.
Enabled Select to enable the account condition.

5 In the Responsibilities block, define the responsibilities that are authorized to use the call 
action result combination.

In this field: Do this:

Responsibility Select the responsibility that can perform the action result 
(required).

Allowed? Yes No Choose “Yes” and access is allowed.
Enabled Select to enable the responsibility.

6 Save the information on the Action Results page.
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Origination tab (Origination page)
The Origination page allows you to determine how applications are directed to users who 
process applications. Whenever applications change status or sub status, the application is 
placed in a queue based on the information on this page.

To set up the Queue Setup form’s Origination page

1 On the Setup menu, choose Queues > Origination.

2 On the Origination page, complete the following fields: 

In this field: Do this:

Queue Name Enter queue name (required).
Queue Description Enter queue description. Note: Oracle Daybreak uses this 

entry when referring to the queue on other forms (see the 
example on the previous page) (required).

Override Responsibility Select an override responsibility code, if an override 
queue. Note: Oracle Daybreak uses the data in the Over-
ride Responsibility field to determine which queue to 
assign an application, if an application triggers an “over-
ride” edit. (required).

Priority Enter the priority number. Oracle Daybreak sorts applica-
tions by the higher number, so an application with a pri-
ority of 5 will be sorted as a higher priority than one with 
a 3 (required).

Company Select company (required).
Branch Select branch (required).
Enabled Select to enable the queue (required).

3 The Selection Criteria block on the Selection Criteria sub page allows you to further filter 
the applications in a particular queue. This block is generally used by organizations pro-
cessing over 2,000 applications a day.

On the Selection Criteria sub page’s Application Status block, use the Status and Sub 
Status fields to define the credit application status/sub status combinations that should be 
considered for the queue.

In this field: Do this:

Status Select application status (required)
Sub Status Select application sub status (required)
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4 In the Selection Criteria block, complete the following fields to define the other selection 
criteria for the queue.

Note: All is the default value for each field.

In this field: Do this:

Product Type Select product type (required).
Funding Type Select funding type (required).
Product Select product (required).
Underwriter Select underwriter (required).
State Select state (required).
Channel Select channel (required).
Producer Type Select producer type (required).
Producer Select producer (required).

5 Choose the Responsibilities and Users sub tab.

6 In the Responsibilities block, use the Responsibility field to define the users by respon-
sibly that are authorized to work on the queue.

7 Select Enabled to enable the responsibility.

8 In the Users block, use the User field to define the users who are authorized to work on 
the queue.

In this field: Do this:

User Select user (required).
Name View the user name (display only).
Enabled Select to enable.

9 Save your entry.
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Customer Service tab (Customer Service page)
The Customer Service page allows you to set up the customer service queues. The page 
includes a Hard Assigned box. When selected, Oracle Daybreak assigns an equal amount 
of accounts to each individual user working on a that queue. Also, an account that is hard 
assigned will remain assigned to the individual who opens that account until that person is 
longer working that queue.

Customer Service command buttons
The Customer Service page contains following three command buttons:

Command button: Function:

Check Criteria Reviews the selection criteria for errors. Oracle Daybreak 
will not allow you to enable a queue with invalid selec-
tion criteria.

Update Queue Queues may be updated whenever selection criteria have 
been updated. They may also be updated manually if the 
nightly batch fails.

Un-Assigned Depends on location of the cursor when you choose this 
button. 
Customer Service page- “Un-assigns” all accounts in 
this queue.
Responsibilities and Users sub page/Responsibilities 
block - “Un-assigns” all accounts in this queue.
Responsibilities and Users sub page/User block - “Un-
assigns” all accounts assigned to the specific user. Unas-
signed accounts may now be selected by updating the 
queue and re-assigned.

To set up the Queue Setup form’s Customer Service page and sub pages

1 On the Setup menu, choose Queues > Customer Service.

2 On the Customer Service page, complete the following fields. 

In this field: Do this:

Queue Name Enter queue name (required).
Queue Description Enter queue description (required).
Account Condition Select account condition (required).
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Priority Enter priority (required).
Company Select company (required).
Branch Select branch (required).
Enabled Select to enable.

3 The Customer Service page includes a Hard Assigned box. When selected, Oracle Day-
break assigns an equal amount of accounts to each individual user working on a that 
queue. Also, an account that is hard assigned remains assigned to the individual who 
opens that account until that person is longer working that queue.

• Use the Hard Assigned indicator to note whether or not the queue is hard assigned.

4 Choose the Selection Criteria sub tab.

5 In the Criteria block, define the account selection criteria with the following fields:

In this field: Do this:

Seq Enter sequence numbers (required).
( Enter left bracket (optional).
Parameter Select the parameter (required).
Comparison Operator Select comparison operator (required).
Criteria Value Enter criteria value (required).
) Enter right bracket (optional).
Logical Expression Enter logical operator (optional).

6 On the Queue Setup form’s Customer Service page, choose Check Criteria.

Oracle Daybreak reviews the selection criteria for errors. 

7 If NO ERROR appears in the Error Message box, choose OK.

8 Choose the Sort sub tab.

9 In the Sort block, define the sort criteria for the account in the queue.

In this field: Do this:

Seq Enter sequence number (required).
Sort Field Select sort field (required).
Order Select sort order (required).
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10 Choose the Responsibilities and Users sub tab.

11 In the Responsibilities block, define the responsibilities that are authorized to work on 
the queue. 

12 Select to Enabled to enable the responsibility.

13 In the Users block, define the users that are authorized to work on the queue and whether 
they are hard assigned (a user or a set of users will be assigned to a queue and will always 
be assigned to it)

Note: Oracle Daybreak allows the work queue list to be sorted by user-defined criteria.

In this field: Do this:

User Select user (required).
Name View user name (display only).
# Assigned View number of accounts assigned (display only).
Hard Assigned Select to hard assign. (For more information, see the fol-

lowing section in this chapter, Using the Hard Assigned 
Feature).

Enabled Select to enable.

14 Save your entry.
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Using the Hard Assigned feature
Oracle Daybreak’s “Hard Assigned” queues feature allows companies to evenly distribute 
accounts between users. The following example explains how it works:

Let’s say there are 100 un-assigned accounts in a queue. Five Oracle Daybreak users are 
assigned to the queue, four of whom are selected as Hard Assigned on the Responsibili-
ties and Users sub page of the Queues Setup form’s Customer Service master tab.

When you select Update Queue on the Customer Service page of the Queue Setup form 
(or Oracle Daybreak processes the CUSTOMER SERVICE QUEUE PROCESSING nightly 
batch) each of the four Hard Assigned users receives 25 accounts, while the one that isn’t 
marked as Hard Assigned receives zero.
 
If Oracle Daybreak users already have accounts assigned to them, Oracle Daybreak 
attempts to balance the workload when assigning new accounts. For example, let’s say 
there are three users in a queue. The first has 15 accounts, the second has ten and the third 
has five. If there are ten new accounts, Oracle Daybreak would give the third user the first 
5 accounts, thus bringing that user's total to ten. Oracle Daybreak splits the next five 
between the second and third, bringing their totals to 13 and 12, respectively. 

Note: Oracle Daybreak randomly assigns these accounts.

To set up a user as Hard Assigned feature

1 From the Setup menu, choose Queues > Customer Service.

2 On the Customer Service page, select the queue with the users you want to hard assign.

3 Select the Hard Assigned box to enable the queue to support the Hard Assigned feature. 

Note: You may have to unlock the record before you can select the check box.

4 Choose the Responsibilities and Users sub tab.

5 In the Responsibilities block, select the level responsibility of the users you want to hard 
assign in the queue.

6 In the Users block, select Hard Assigned for each user you want to hard assign.

7 On the Customer Service page, choose Update Queue to distribute the applications in 
the queue to the hard assigned users.   

Oracle Daybreak displays a Forms dialog box with the message “Queue creation submit-
ted in background”. 

8 Choose OK to close the Forms dialog box.

9 Choose OK beneath the Error Message list box containing the words NO ERROR.

Oracle Daybreak distributes and hard assigns the accounts in the queue to the selected 
users in the Users block.

Note: If the accounts are not allocated to the hard assigned user, place the cursor is in the 
Users block and press F8. 
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To remove a user

1 From the Setup menu, choose Queues > Customer Service.

2 On the Customer Service page, select the queue with the users you want to remove.

3 If you don’t want that user to be hard assigned any longer, clear the Hard Assigned check 
box. 

4 If you don’t want that user to be assigned to that queue any longer, clear the Enabled 
check box. 

Note: You may have to unlock the record before you can select the check box.

Oracle Daybreak updates the number of accounts assigned to a user only after:

• The nightly batch job runs
-or-

• You choose the Update Queue button.
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CHAPTER 6 : EVENTS FORM

The Events form gives you the ability to set up “trigger events” with associated actions 
which Oracle Daybreak performs during account processing. The fields on this form are 
both system and user defined. 

During account processing, when an account moves from one status/sub status to another, 
or changes condition, Oracle Daybreak can trigger an event and perform the associated 
event actions. This can occur either online or in batch mode. There are three pages on the 
Events form to set up and maintain these events:

• Setup page
• Online page
• Batch page

Note: Only predefined events and actions can be set up on the Events form. You cannot 
create new event types or actions types.

As processing events and associated actions require additional processing at the server 
level, the performance of the transactions, for which the events are set up, may be 
adversely affected dependent upon your specific configuration.

Setup tab (Setup page)
The Setup page contains two predefined blocks of information, the Event Types block and 
the Event Action Types blocks. This page and its two blocks provide a master table for set-
ting up the online and batch events. This setup triggers the event, which in turn triggers the 
event’s associated actions during account processing. 

To set up the Setup page

1 On the Setup menu, choose Events.

2 Select the Lease product to which the event applies.
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3 The Event Types block is system defined and lists the event type codes supported in Ora-
cle Daybreak.

In this field: Do this:

Event Type Code Enter the event type code (required).
Description Enter the event description (required).
Process Type Enter the process type (BATCH or ONLINE) 

[EVENT_PROCESS_TYPE_CD] (required).
Entity Type Enter the entity type (ACCOUNTS) 

[EVENT_ENTITY_TYPE_CD] (required).
Engine Type Enter the engine type (MONETRARY TRANSACTIONS 

PROCESSING, NON-MONETRAY TRANSACTION PRO-
CESSING, CONDITION/ASSIGNMENT PROCESSING, 
APPLICATION STATUS CHANGE, CREDIT BUREAU 
PROCESSING, or CORRESPONDENCE) 
[EVENT_ENGINE_TYPE_CD] (required).

4 Select or clear the Enabled box to activate or disable the event type.

5 System is a display only check box. If selected, it indicates that the event type is system 
define. If cleared, it indicates that the event type is user defined.

6 The Event Action Types block is system defined and lists the action codes supported in 
Oracle Daybreak.

In this field: Do this:

Action Code Enter the action code (required).
Description Enter the action description (required)
Process Type Enter the process type (BATCH or ONLINE) 

[EVENT_PROCESS_TYPE_CD] (required)
Entity Type Enter the entity type (ACCOUNTS) 

[EVENT_ENTITY_TYPE_CD] (required)
Engine Type Enter the engine type (MONETRARY TRANSACTIONS 

PROCESSING, NON-MONETRAY TRANSACTION PRO-
CESSING, CONDITION/ASSIGNMENT PROCESSING, 
APPLICATION STATUS CHANGE, CREDIT BUREAU 
PROCESSING, or CORRESPONDENCE) 
[EVENT_ENGINE_TYPE_CD] (required).

7 Select or clear the Enabled box to activate or disable the action.

8 System is a display only check box. If selected, it indicates that the action is system 
define. If cleared, it indicates that the action is user defined.

9 Save your entry.
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Online tab (Online page)
The Online page allows you to set up the events performed online by Oracle Daybreak. 
Oracle Daybreak supports the following online events:

1 A change in account’s status. Oracle Daybreak processes the event's actions when the:

• Account status of ACTIVE is reversed
• Account status is changed to PAID
• Account status change to PAID is reversed
• Account status is changed to CHARGE OFF
• Account status change to CHARGE OFF is reversed.

2 The opening or closing of an accounts conditions. Oracle Daybreak processes the event’s 
actions when the:

• Account condition DELINQUENT is opened
• Account condition DELINQUENT is closed

3 The posting of a non-monetary transaction to the account.

The events that can be performed online after each of the events listed above are as fol-
lows:

• Send correspondence for an account
• Generate correspondence for an account
• Send a credit bureau request for an account
• Post a monetary transaction for an account
• Post a condition transaction for an account

The Online page allows you to set up the online events by defining all online events and 
the event criteria actions. 

To set up the Online page

1 On the Setup menu, choose Events.

2 Select the Lease product to which the event applies.
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3 Select the Online tab.

4 In the Events block, enter the following information:

In this field: Do this:

Event Code Enter the event code (required).
Event Type Enter the event type (required).
Frequency Enter the event frequency 

[EVENT_FREQUENCY_TYPE_CD] (required).

5 Select the Synchronous box to set the event as synchronous (any failure in triggering the 
event will fail to trigger the entire transaction).-or- 

Clear the Synchronous box to set the event as asynchronous (any failure in the event will 
not affect the transaction, which will be successfully completed).

6 Select or clear the Enabled box to activate or disable the event type.

7 The Events Criteria block allows you to name and describe the query for an event, as well 
as enable or disable the query. Use this block to enter the following information:

In this field: Do this:

Query Name Enter the query name (required).
Description Enter the query description (required).

8 Select or clear the Enabled box to activate or disable the event criteria.

Criteria Details sub page
The Criteria Details sub page allows you to define the selection criteria for the event. The 
event engine uses these criteria to determine which accounts to include in the event action.

To set up the Criteria Details sub page

1 On the Setup menu, choose Events.

2 Select the Lease product to which the event applies.

3 Select the Online tab.

4 Select the Criteria Details sub tab.

5 In the Criteria block, define the event selection criteria with the following fields:

In this field: Do this:

Seq Enter sequence numbers (required).
( Enter left bracket (optional).
Parameter Select the parameter (required).
Comparison Select comparison operator 

[COMPARISON_OPERATOR_CD] (required).
Criteria Value Enter criteria value (required).
) Enter right bracket (optional).
Logical Enter logical operator (optional).

6 Save your entry.
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Action sub page

The Actions sub page records the actions Oracle Daybreak performs after the event is 
triggered.

 To set up the Action sub page

1 On the Setup menu, choose Events.

2 Select the Lease product to which the event applies.

3 Select the Online tab.

4 Select the Action sub tab.

5 In the Actions block, define the action you want Oracle Daybreak to perform for the event 
by entering the following information. (You can set up more than one event action for a 
particular event, then use the Seq field to define the order in which the events will occur):

In this field: Do this:

Event Action Enter the event action (required).
Seq Enter sequence numbers (required).

6 For each event action, use the Action Parameters block to set up the required action 
parameters and values. 

In this field: Do this:

Parameter Enter the event action (required).
Value Enter sequence numbers (required).

7 Select or clear the Enabled box in the Actions block to activate or disable the event 
action.

8 Save your entry.
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Batch tab (Batch page) 
The Batch page allows you to set up the events performed as a batch transaction by Oracle 
Daybreak. Oracle Daybreak supports the following predefined batch events for account 
processing. (These batch events are listed in the Events Types block on the Setup page): 

• ACCOUNT LEVEL BATCH EVENT #01
• ACCOUNT LEVEL BATCH EVENT #02
• ACCOUNT LEVEL BATCH EVENT #03
• ACCOUNT LEVEL BATCH EVENT #04
• ACCOUNT LEVEL BATCH EVENT #05
• ACCOUNT LEVEL BATCH EVENT #06
• ACCOUNT LEVEL BATCH EVENT #07
• ACCOUNT LEVEL BATCH EVENT #08
• ACCOUNT LEVEL BATCH EVENT #09
• ACCOUNT LEVEL BATCH EVENT #10

To set up the Batch page

1 On the Setup menu, choose Events.

2 Select the Lease product to which the event applies.

3 Select the Batch tab.

4 On the Batch page, use the Events block to enter the following information:

In this field: Do this:

Event Code Enter the event code (required).
Event Type Enter the event type (required).
Frequency Enter the event frequency 

[EVENT_FREQUENCY_TYPE_CD] (required).

5 The Synchronous box is cleared as all batch events are set as asynchronous; any failure 
in the event will not affect the transaction, which will be successfully completed.

6 Select or clear the Enabled box to activate or disable the event type.

7 The Events Criteria block allows you to name and describe the query for an event, as well 
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as enable or disable the query. Use this block to enter the following information:

In this field: Do this:

Query Name Enter the query name (required).
Description Enter the query description (required).

8 Select or clear the Enabled box to activate or disable the event criteria.

Criteria Details sub page
The Criteria Details sub page allows you to define the selection criteria for the event. The 
event engine uses these criteria to determine which accounts to include in the event action. 

To set up the Criteria Details sub page

1 On the Setup menu, choose Events.

2 Select the Lease product to which the event applies.

3 Select the Batch tab.

4 Select the Criteria Details sub tab.

5 In the Criteria block, define the event selection criteria with the following fields:

In this field: Do this:

Seq Enter sequence numbers (required).
( Enter left bracket (optional).
Parameter Select the parameter (required).
Comparison Select comparison operator 

[COMPARISON_OPERATOR_CD] (required).
Criteria Value Enter criteria value (required).
) Enter right bracket (optional).
Logical Enter logical operator (optional).

6 Save your entry.
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Actions sub page
The Action sub page allows you to define the actions performed in the batch event. Oracle 
Daybreak supports the following batch event actions:

• Send letter for an account 
• Generate correspondence for an account 

To set up Action sub page

1 On the Setup menu, choose Events.

2 Select the Lease product to which the event applies.

3 Select the Batch tab.

4 Select the Action sub tab.

5 In the Actions block, define the action you want Oracle Daybreak to perform for the event 
by entering the following information. (You can set up more than one event action for a 
particular event, then use the Seq field to define the order in which the events will occur):

In this field: Do this:

Event Action Enter the event action (required).
Seq Enter sequence numbers (required).

6 For each event action, use the Action Parameters block to set up the required action 
parameters and values. 

In this field: Do this:

Parameter Enter the event action (required).
Value Enter sequence numbers (required).

7 Select or clear the Enabled box in the Actions block to activate or disable the event 
action.

8 Save your entry.
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Monitoring events
You can verify the status of events and event actions on the Monitor Jobs page of the Util-
ities form. 

To monitor events

1 On the Monitor menu, choose System > Jobs.

2  On the Monitor Jobs block, choose Back Ground in the Job Type block. 

Oracle Daybreak displays the status for all asynchronous events that have been completed 
or failed for an account.
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CHAPTER 7 : CREDIT BUREAU SETUP FORM

In Oracle Daybreak, an important part of the origination process is pulling a credit report 
from a credit bureau and scoring that information against a user-defined risk model. These 
credit reports can be pulled both automatically and manually.

After you enter an application, Oracle Daybreak compares its contents against prescreen 
criteria. If the application passes a prescreen edits check, Oracle Daybreak advances the 
status of the application and automatically pulls a credit report.

You can manually request a credit report for an applicant or any other party included on 
the application, such as cosigners and spouses by selecting the bureau from which you 
want to pull the report. If more than one report type is defined for the selected bureau, you 
can indicate the type of report you want to pull.

The Oracle Daybreak credit bureau service has been enhanced to support the Experian Net 
Connect and Equifax Internet System to System interfaces. Experian Net Connect and 
Internet System to System are client/host gateways designed to allow access to credit 
bureau agency systems through the public Internet. With this enhancement, the Oracle 
Daybreak credit bureau service can access Experian and Equifax systems using any one of 
three methods -dial-up modem, frame relay, and now the Internet. Experian has announced 
that they are de-supporting dial-up access as of May 31, 2004. The Oracle Daybreak credit 
bureau service will not be immediately modified to remove support for Experian dial-up 
connections, but after May 31, 2004 the credit bureau service will effectively only support 
two connectivity methods for accessing Experian systems. Current Oracle Daybreak cus-
tomers accessing Experian through dial-up will need to choose between frame relay and 
Net Connect before May 31, 2004 to avoid a disruption of service.

Credit Bureau Setup details
• The credit bureau from which the report is pulled is determined by the applicant’s zip 

code. The credit bureau interface searches the information in the Credit Bureau Zip 
Matrix tab and matches the applicant’s zip code to determine the bureau(s) from 
which to request a report.

• The number of credit reports automatically pulled per applicant is controlled through 
the credit request parameter CRB_MAX_BUREAU_PULL. If this parameter is set to 1, 
a credit bureau request will be made for the Bureau1 credit bureau from the zip code 
matrix. Likewise, if this parameter is set to 2, a credit bureau request will be made for 
the Bureau1 and the Bureau2 credit bureaus from the zip code matrix.

• Oracle Daybreak automatically pulls credit reports for only the primary applicant and 
the primary applicant's spouse (for joint applications) unless the 
CRB_ALL_APL_BUREAU_PULL credit request parameter is set to Y. However, if the 
parameter is set to Y, Oracle Daybreak pulls credit reports for all applicants on the 
loan, regardless of their relationship to the primary borrower.

• Passwords, default report formats, and other required information from the credit 
bureaus are set up in the Report Formats page.
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Preparing to use Experian credit reports
Contact an Experian sales representative for information about pulling Experian credit 
reports. After the proper agreements are completed, and depending on the access method 
chosen, Experian will provide you with the necessary information needed to set up the 
credit bureau service in Oracle Daybreak. On Oracle Daybreak’s Credit Bureau Setup 
form, on the Report Format page, the Credit Bureau Setup block uses generic terms for the 
data needed for credit bureau access. Some of the fields are not always required, and 
Experian employees may use different names in conversation when discussing these 
fields. 

The following table summarizes the data needed for each Experian access method:

There should be no need to get new member codes and passwords when switching credit 
bureau access methods (moving from dial-up to Net Connect). The member codes and 
passwords are not dependent on the connection method used to access the bureau.

Frame relay access is from the database server to the Experian host though a TCP/IP 
socket connection. The connection is outbound only and it is to a specific port (699 or 
700) on the Experian host.

The Oracle Daybreak credit bureau service will be accessing Experian Net Connect ser-
vice through HTTP to the ECALS URL supplied by Experian as well as by the HTTPS to 
the URL returned as a response to the ECALS URL inquiry (the credit request URL). This 
access is from the database server (not the iAS server) and access through a proxy server is 
not supported. The connections are outbound only and they connect to the standard ports 
at Experian (80 for the ECALS URL, 443 for the credit request URL).
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Preparing to use Equifax credit reports
Contact an Equifax sales representative for information about pulling Equifax credit 
reports. After the proper agreements are completed, and depending on the access method 
chosen, Equifax will provide you with the necessary information needed to setup the 
credit bureau service in Oracle Daybreak. On Oracle Daybreak’s Credit Bureau Setup 
form, on the Report Format page, the Credit Bureau Setup block uses generic terms for the 
data needed for credit bureau access. Some of the fields are not always required, and 
Equifax employees may use different names in conversation when discussing these fields. 

The following table summarizes the data needed for each Equifax access method.

There should be no need to get new member codes and passwords when switching credit 
bureau access methods (moving from dial-up to Internet System to System), the member 
codes and passwords are not dependent on the connection method used to access the 
bureau. 

Frame relay access is from the database server to the Equifax host through a TCP/IP 
socket connection. The connection is outbound only and it is to a specific port (6091) on 
the Equifax host.

The Oracle Daybreak credit bureau service will be accessing the Equifax Internet System 
to System service through HTTPS to the URL supplied by Equifax. This access is from 
the database server (not the iAS server) and access through a proxy server is not sup-
ported. The connections are outbound only and they connect to the standard HTTPS port 
at Equifax (443).
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Preparing to use TransUnion credit reports
Contact an TransUnion sales representative for information about pulling TransUnion 
credit reports. After the proper agreements are completed, and depending on the access 
method chosen, TransUnion will provide you with the necessary information needed to 
setup the credit bureau service in Oracle Daybreak. On Oracle Daybreak’s Credit Bureau 
Setup form, on the Report Format page, the Credit Bureau Setup block uses generic terms 
for the data needed for credit bureau access. Some of the fields are not always required, 
and TransUnion employees may use different names in conversation when discussing 
these fields. 

The following table summarizes the data needed for each TransUnion access method.

There should be no need to get new member codes and passwords when switching credit 
bureau access methods (moving from dial-up to frame relay), the member codes and pass-
words are not dependent on the connection method used to access the bureau. 
Frame relay access is from the database server to the TransUnion host through a TCP/IP 
socket connection. The connection is outbound only and it is to a specific port (10001) on 
the TransUnion host.

Preparing to use CSC credit reports
Contact an CSC sales representative for information about pulling CSC Tri-Merge credit 
reports. After the proper agreements are completed, and depending on the access method 
chosen, CSC will provide you with the necessary information needed to setup the credit 
bureau service in Oracle Daybreak. On Oracle Daybreak’s Credit Bureau Setup form, on 
the Report Format page, the Credit Bureau Setup block uses generic terms for the data 
needed for credit bureau access. Some of the fields are not always required, and CSC 
employees may use different names in conversation when discussing these fields. 

The following table summarizes the data needed for each CSC access method.

The Oracle Daybreak credit bureau service will be accessing CSC Tri-Merge via HTTPS 
to the URL supplied by CSC. This access is from the database server (not the iAS server) 
and access through a proxy server is not supported. The connections are outbound only 
and they connect to the standard HTTPS port at CSC (443).
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Preparing to use Credco credit reports
Contact a First American Credco sales representative for information about pulling 
Credco credit reports. First American Credco offers many different products and services. 
Oracle Daybreak supports pulling merged credit reports from the CredcoConnect interface 
operating in a server to server mode. After the proper agreements are completed, Credco 
will provide you with the necessary information needed to set up the credit bureau service 
in Oracle Daybreak. On Oracle Daybreak's Credit Bureau Setup form's Report Format 
page, the Credit Bureau Setup block uses generic terms for the data needed for credit 
bureau access. Some of the fields are not always required, and Credco employees may use 
different names in conversation when discussing these fields. 

The following table summarizes the data needed for each CSC access method.

The Oracle Daybreak credit bureau service will be accessing CredcoConnect via HTTPS 
to the URL supplied by Credco. This access is from the database server (not the iAS 
server) and access through a proxy server is not supported. The connections are outbound 
only and they connect to the standard HTTPS port at Credco (443).

In addition to the member code, password, origin code, and URL, you will also need a cli-
ent certificate file and public key from Credco. The certificate and key are used to authen-
ticate the connection between Oracle Daybreak and CredcoConnect. Request the client 
certificate in Windows PFX format. The Oracle Daybreak Lending Suite interface will 
ultimately use the file in PKCS12 format, but it is easier to install if it starts out as a PFX 
file. (See the later section on Oracle Wallet Manager setup for instructions on what to do 
with the certificate file.)
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Reporting master tab (Reporting page)
Oracle Daybreak reports to the credit bureau agencies in the Metro 2 format with the pay-
ment and account status information of each account holder. The Reporting page contains 
the program identifier to be reported to the bureaus. 

To create a credit bureau reporting program

1 On the Setup menu, choose Credit Bureau > Reporting.

2 Choose the Reporting tab.

3 Complete the Credit Bureau Reporting block with the following information:

In this field:  Do this:

Company Select the portfolio company (required).
Bureau Select the bureau (required).
Program Identifier Enter the program identifier. The customer receives this 

from the bureau and uses it to identify itself to that 
bureau. You will need to update this information 
(required).

4 Select Enabled to enable the program.

5 Save your entry.
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Special Metro II Code reporting
Oracle Daybreak allows you to report the following special Metro II segments to the credit 
bureau output file: 

• Consumer Information Indicator Code (CIIC)
• Compliance Condition Code (CCCD)
• Special Comment Code (SPCC). 

Oracle Daybreak users will need to use call Action/Results and Reason fields on the Call 
Activities sub page of the Customer Service form (Lending > Customer Service > Cus-
tomer Service (2) master tab > Account Details tab > Call Activities sub tab) to place spe-
cific account conditions where these Metro II segments are to be reported.   The specific 
segment reported for a given condition will be based on the account condition and call 
activity reason codes. 

Note: It is the responsibility of the Oracle Daybreak Administrator or individual user to 
setup Special Metro II Code reporting functionality.

When users open one of the following conditions:

CIIC CONSUMER INFORMATION INDICATOR CODE (METRO2 - FCRA)
CCCD COMPLIANCE CONDITION CODE (METRO2)
SPCC SPECIAL COMMENT CODE (METRO2)

Oracle Daybreak recognizes the condition, processes the selected Metro II reporting call 
activity reason code, and generates the Metro II reporting segment in the Metro II report-
ing output file. 

Note: You (the Oracle Daybreak user) are responsible for selecting the correct Metro II 
reporting segment reason code to be reported. If you do not select a Metro II reporting seg-
ment reason code, Oracle Daybreak will not generate information to Metro II output file.   
If you select an incorrect (wrong) Metro II reporting segment reason code, Oracle Day-
break will report the selected Metro II reporting segment. Oracle Daybreak does not vali-
date the contents of the Reason field with the contents of the Condition field.

To end the reported Special Metro II Special Code, close the open Special Metro II Condi-
tion (no reason code needed). Oracle Daybreak recognizes the closing of the open Special 
Metro II Condition and will not create a Metro II reporting segment in the output file.

IMPORTANT: 
The CBU_FILE_FREQUENCY (METRO 2 FILE FREQUENCY) Company system parameter 
determines if output file is generated and created daily or output file is written with daily 
data and output monthly.
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To set up Metro II Code reporting

1 On the Setup menu, choose Queues > Setup. 

2 In the Call Actions and Call Results blocks, set up to open and close the following sys-
tem defined condition codes to open and close:

Action Code Description
CIIC CONSUMER INFORMATION INDICATOR CODE (METRO2 - FCRA)
CCCD COMPLIANCE CONDITION CODE (METRO2)
SPCC SPECIAL COMMENT CODE (METRO2)

When setup is completed, you can open and close Special Metro II code conditions. 

Note: Opening and closing Special Metro II Code reporting is a manual process.

The CBU_FILE_FREQUENCY (METRO 2 FILE FREQUENCY) Company system parameter 
determines if output file is generated and created daily or output file is written with daily 
data and output monthly. 
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Oracle Wallet Manager setup
The Experian Net Connect, Equifax Internet System to System, and CSC interfaces within 
the Oracle Daybreak credit bureau service use functionality provided by the Oracle Wallet 
feature. Use the Oracle Wallet Manager on the database server to create and export a wal-
let for use by the Oracle Daybreak credit bureau service.

Note: All of the above mentioned interfaces use the same Oracle wallet. If a wallet already 
exists and is in use by one of the credit bureau interfaces, there is no need to create another 
wallet. Due to differing certificate requirements, there may be a need to import additional 
trusted certificates into the wallet, but there will not be a need to create a new one. The 
Oracle Daybreak credit bureau parameter ORA_WALLET_PATH contains the location of 
the Oracle Wallet used by the Oracle Daybreak credit bureau service. 

To create and export a wallet suitable for use by the Oracle Daybreak credit 
bureau 

Please refer to the Oracle documentation for more detailed instructions on how to use the 
Oracle Wallet Manager to create and manage a wallet):

1 If one does not already exist, create a wallet somewhere on the database server. The loca-
tion must be readable and writable by the Oracle user. Make a note of the full path where 
the wallet is stored (for example, /etc/ORACLE/WALLETS/oracle or C:\ora-
cle\WALLETS).

2 The wallet needs to contain the public key for the certificate authority that issued the 
server certificate for each HTTPS web site that will be connected to by the credit bureau 
interface. At the time of this document, those sites are:

https://ss1.experian.com Experian
https://transport5.ec.equifax.com Equifax
https://www.emortgage.Equifax.com CSC
https://www.credcoconnect.com Credco

This list may change. Use the URL provided to you by the credit bureau when they set up 
your service.   To get the proper Experian HTTPS URL, enter the ECALS URL that was 
provided by Experian into a web browser. The response returned to the browser is the 
HTTPS URL that will be used to communicate with Experian.

3 Import the necessary certificate authority’s certificate files into the Oracle wallet that was 
created in Step 1. See the appendix of this chapter for detailed instructions of how to 
download and install a trusted certificate.

4 Test the wallet by connecting to each web site with a simple command issued from SQL-
Plus.

SQL> select utl_http.request('https://ss1.experian.com', 
NULL, 'file:/etc/ORACLE/WALLETS/oracle', 'password') from 
dual;

Replace the URL in the above command with each HTTPS URL given to you for use by 
the credit bureaus. Also replace the wallet path with the path to your wallet and your wal-
let password. The output from the command is not important, what is important is that it 
runs without displaying an Oracle error. If there is an Oracle error, then something is 
wrong with the contents of the wallet, the path to the wallet, and/or the wallet password.
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5 When the wallet contains all of the required trusted certificates, export the wallet to a text 
file. On the Operations menu on the Oracle Wallet Manager, choose Export All Trusted 
Certificates. The text file MUST be located in the same directory as the wallet and the 
filename MUST be default.txt. Anytime a change is made to the trusted certificates in the 
wallet, the wallet must be re-exported to the same text file.

6 From Oracle Daybreaks Setup menu, choose Credit Bureau > Request > Parameters 
tab within and set the ORA_WALLET_PATH and ORA_WALLET_PASSWORD parameters. 

To create and a client certificate wallet suitable for use by the CredcoConnect 
interface 

The CredcoConnect interface requires another wallet file in addition to the default wallet 
file. This additional wallet file contains the client certificate and certificate chain issued to 
your company by First American Credco when your account is created. 

1 Save the client certificate file sent to you by First American on your local PC.

2 Open Microsoft Internet Explorer. Go to the Tools > Internet Options > Content > Cer-
tificates screen.

3 Click the Import button. Choose Next and the locate the PFX file you saved in Step 1. 
Choose Next and enter the password provided to you by Credco for the certificate file. 
Select the Enable string private key protection and Mark the private key as export-
able check boxes. Choose the default selections on the following screens until the import 
is successful.

4 On the Certificate Manager screen, select the First American Corporation certificate and 
click the Export button.

5 Choose Next, Yes, export the private key, Next, PKCS12 format, include all certificates in 
the certification path, and enable strong protection and Next.

6 Set the password for the certificate to be the same password as your Oracle wallet.

7 Choose Next and save the file as credco.p12.

8 Copy the credco.p12 file to your database server and into the same directory where the 
existing Oracle wallet in use by Oracle Daybreak is located.
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Oracle JVM Security setup
The Experian Net Connect interface within the Oracle Daybreak credit bureau service 
requires the use of the Oracle Java Virtual Machine (JVM) that is resident in the Oracle 
database. Furthermore, specific permissions must be granted to the Java classes used by 
the credit bureau service. These permissions have been added to the set_java_perms.sql 
script that is part of the Oracle Daybreak Lending Suite distribution. This script (as well as 
many other useful SQL scripts) is available from the i-flex solutions technical support 
Oracle Daybreak Lending Suite patches web site at http://support.supersolu-
tion.com/LSPatches/ patch_installation_utilities.zip.

The set_java_perms.sql script needs to run as the SYS user (or a user with SYS privi-
leges). The script will prompt for SYS user id and password. Be prepared to provide it 
when prompted. Also, the script will select the value of the ORA_WALLET_PATH parame-
ter from the credit bureau parameters table. Make sure that it has been updated with the 
proper wallet path before running the set_java_perms.sql script (although the script can be 
safely run again if necessary).

Credit Bureau Service operation
The basic operation of the credit bureau service has not changed. Once setup, there is no 
operational difference between accessing the credit bureaus via dial-up, frame relay, or the 
Internet.

Importing a trusted certificate into an Oracle Wallet
The HTTPS servers used by Experian, Equifax, and CSC for their Internet based credit 
report services (as well as all HTTPS servers) contain a site certificate signed by a trusted 
Certificate Authority (CA). The CA is an entity that guarantees the identity of the HTTPS 
server. If the client trusts the CA, and the CA says that the HTTPS server is who they say 
they are, then the client inherently trusts the HTTPS server. Normally, a client tool such as 
Microsoft Internet Explorer has a large store of trusted CA certificates which makes 
secure communication between a client and a trusted HTTPS server relatively seamless 
and uneventful. Unfortunately, the store of CA certificates in the default Oracle wallet is 
rather small and it is likely that it will not contain the certificate of the CA that is certify-
ing one or more of the credit bureau web sites. This means that the CA certificate must be 
imported into the wallet. To do this, the certificates must first be exported from a browser 
and then imported into the Oracle wallet using the Oracle Wallet Manager.

Using Microsoft Internet Explorer to Export a Certificate

1 Use Microsoft Internet Explorer and connect to one of the HTTPS URLs referenced in the 
Oracle Wallet Manager Setup section of this document. 

If the web site asks for a user id and password, cancel the dialog box and remain on the 
top-level HTTPS page.

2 Once connected, from the browser’s File menu, choose Properties.

3 Choose the Certificates button.
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4 Choose the Certification Path tab. The bottom-most certificate is the one generated by the 
host itself. We are not interested in that one, we are interested in the one or more certifi-
cates above the bottom-most one. The screen shot below displays a web site with two CAs 
(an intermediate, and a primary). Whether it is an intermediate CA or a primary one, the 
steps are the same for saving the certificate as a text file.

5 Choose the first certificate above the bottom-most certificate (it may be the only certificate 
above the bottom-most certificate).

6 Choose the View Certificate button.

7 Choose the Details tab.

8 Choose the Copy to File button.

9 Choose the Next button.

10 Choose the Base 64 encoded format.

11 Choose the Next button.

12 Enter a filename and location for the file.

13 Choose the Next button.

14 Choose the Finish button.

15 Repeat steps 5 through 14 for the next certificate in the certification path (if any).
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Importing the Certificates into an Oracle Wallet
1 Copy the certificates exported and saved during the process described above onto the data-

base server (not the iAS server).

2 As the Oracle user (or Administrator on Windows), start the Oracle Wallet Manager.

3 Open the wallet that will be used by the Oracle Daybreak credit bureau service. Create a 
new wallet if one does not already exist.

4 View the list of Trusted Certificates in the wallet.

5 Check the list of certificates against the list of certificates that are in use on the HTTPS 
servers used by the credit bureaus (and that were exported and saved during the export 
process described above). 

6 Click the Trusted Certificates heading in the left list box of the Oracle Wallet Manager. 

7 Use Microsoft Internet Explorer to view the certificate details for the HTTPS web sites 
(File > Properties > Certificates > Certification Path > View Certificate > General) that 
will be contacted by the credit bureau service.   Look through the list of certificates shown 
in the right panel of the Oracle Wallet Manager and look for a match between the Issued 
To and Valid To dates shown in the Internet Explorer View Certificate Window. 
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The screen shot below shows a certificate that is already in the wallet’s list of trusted cer-
tificates (see the last entry for the www.verisign.com/CPS certificate).

8 On the Operations menu, choose Import Trusted Certificate and follow the prompts for 
locating and loading the files that were copied onto the database server in step 1 for any 
certificate not already stored in the wallet.

9 On the Wallet menu, choose Save when finished loading certificates.
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De-duping Credit Bureau data
Oracle Daybreak allows you to remove duplicate (“de-dupe”) liabilities data from the 
credit bureau information.

De-duping logic
The de-duping logic is based on a number of parameters that Oracle Daybreak compares 
among tradelines (only) to determine if they are duplicates. The following fields are used 
to determine if two tradelines are duplicates:

Field: Description:

Account # The account number of the consumer with the 
lender for the particular account.

Open Date The date the account was opened.

Member Code The subscriber code of the lender with the 
respective credit bureau. 
Note: Since member codes for the same lender 
differ across bureaus, this field is used only for 
tradelines reported by the same bureau. Since 
reports obtained from CSC can have tradelines 
from different bureaus, this field is only for 
reports pulled from the credit bureaus.

All available bureau reports pulled later than DEDUP_CRB_EXPIRATION_DAYS days old 
will be used.

The following system parameters will be set up to provide switches to allow the function-
ality to be turned on and off:

Whenever two (or more) items are identified as duplicates, Oracle Daybreak uses the fol-
lowing hierarchy to pick one of the items as the “correct” one:

1 Last Reported Date: The row that has been reported most recently is used.

2 Owner: In case of a tie on the last reported date, one of the tradelines is picked in the 
descending order of priority depending on who the tradeline belongs to: Primary, 
Spouse, then Secondary.
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Debt Ratio combination
Oracle Daybreak uses the system parameter DBR_JOINT_INC_DEBT_WITH_SPOUSE to 
decide whether to combine debt ratios of the spouse with the primary applicant. The 
DBR_JOINT_INC_DEBT_WITH_COAPP parameter decides whether to do the same on a 
non-spousal joint application. 

When this indicator is checked, all liabilities in the Liability block on the Summary sub 
page of the Applicant (2) master tab with the Include box selected will be used in the debt 
ratio calculation.

The following system parameter will be set up to provide switches to allow the functional-
ity to be turned on and off:

De-duping process
The de-duping logic will be integrated into the Oracle Daybreak decision-making process 
in the following manner:

Initial credit pulls on new applications

• If the JOINT_DEDUP_SPOUSE_LIABILITIES/ JOINT_DEDUP_ALLAPL_LIABILITIES 
system parameters are set to Y, Oracle Daybreak uses the de-duping logic described 
above to uncheck the duplicate liabilities in the spouse's/co-applicant’s liabilities.

• If the DBR_JOINT_INC_DEBT_WITH_SPOUSE/ 
DBR_JOINT_INC_DEBT_WITH_ALLAPL parameters are set to Y, Oracle Daybreak 
includes the liabilities of the spouse/ co-applicant while calculating the debt ratio of 
the primary applicant.

• Oracle Daybreak will use all available credit reports at the time.

Subsequent credit pulls (manual) 

• To remove duplicate liabilities from the calculation, choose the Dedup Liabilities but-
ton on the Underwriting form (Applicants (9) master tab > Summary sub page > Lia-
bility block). (Potential record locking situations force the action to remain manual 
versus the system automatically doing it).

• If the Populate Debt and Include Debt boxes are selected in the Applicant/Cus-
tomer Detail block on the Bureau (4) master tab on the Underwriting form for the 
credit request and the JOINT_DEDUP_SPOUSE_LIABILITIES/ 
JOINT_DEDUP_ALLAPL_LIABILITIES system parameters are set to Y, Oracle Day-
break will use the de-duping logic described above to uncheck the duplicate liabilities 
in the spouse's/co-applicant's liabilities.

• If the DBR_JOINT_INC_DEBT_WITH_SPOUSE/ 
DBR_JOINT_INC_DEBT_WITH_COAPL parameters are set to Y, Oracle Daybreak will 
include the liabilities of the spouse/ co-applicant while calculating the debt ratio of the 
primary applicant.
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• Oracle Daybreak will use all available credit reports at the time of the request that 
have been requested within the number of days specified in the 
DEDUP_CRB_EXPIRATION_DAYS parameter.

Restrictions
The de-duping logic will be limited based upon the discussion above. If Oracle Daybreak 
cannot identify two tradelines as duplicates based upon the logic mentioned above, the 
individual tradelines will be retained. In such circumstances, both tradelines will be used 
in the debt ratio calculation and it will be the user’s responsibility to disregard one of them 
by clearing the Include check box.
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CHAPTER 8 : UTILITIES FORM

“Batch jobs” refer to back-end processes that automatically run at a certain time. There are 
two types of batch jobs: 

• Business processes (such as billing and delinquency processing)
• Housekeeping tasks (such as application aging and application purging)

The Utilities form allows you to set up, monitor, and maintain batch jobs in Oracle Day-
break. 

Batch jobs can be set up to be performed on a daily, weekly, monthly, and ad-hoc basis. 
Batch jobs can also be configured to trigger an e-mail or phone message if a batch job 
should fail. 

Critical batch jobs control job flow and system date rollover to allow recovery during 
errors. Errors are instances where a process did not successfully complete. Failures indi-
cate that a particular job encountered errors that require remedial action. The number of 
errors allowed before failure is defined for each job. Some errors automatically result in a 
failure.

The Log Files page allows you to view errors and failures.

The Utilities form Setup tab contains the following pages:

• Batch Job page
• Job Holiday page

Setup tab (Batch Job page)
The Utilities form’s Batch Job page allows you to track and maintain of all batch processes 
within the Oracle Daybreak system. Using this form, the system administrator can config-
ure the frequency and start time of each batch process, as well as set the number of threads 
to improve performance.

“Threading” allows a specific job to be separated into smaller units that are processed at 
the same time. This allows Oracle Daybreak to complete the job in less time.

You can set up multiple batch jobs within a batch set. In the Batch Job Sets block, each 
process is listed with the last run date (Last Run Dt field) and the next scheduled process 
date (Next Run Dt field). In the Freq Code and Freq Value fields, you can determine the 
frequency of each batch set, such as daily, weekly and monthly. You can also set up batch 
sets to incorporate a dependency on another batch set. This way, if the initial batch fails, 
the dependent set will not be processed.

In the Batch Jobs block, you can configure the process to run on weekends and holidays 
using the respective option boxes.
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CAUTION:
As the batch job setup widely affects the Oracle Daybreak system, it suggests that the sys-
tem administrator has a clear understanding of the various functionalities within Oracle 
Daybreak before creating and updating the batch processes.

For the standard job set please review the Visio document, 
dbk_std_detail_design_job_sets.vsd

To set up a batch job

1 On the Setup menu, choose Batch Jobs.

2 Complete the Batch Job Sets block:

In the field: Do this:

Set Code Enter code for batch job set (required).
Job Set Description Enter description for batch job set (required).
Freq Code Select frequency at which the job set is to be executed 

(required).
Freq Value Select frequency value (required).
Start Time Enter start time for the job set (required).
Last Run Dt View last run date of the job set (display only).
Next Run Dt Enter next run date for job set (required).
Parent Select parent job set (required).
Dependency Select type of dependency on the parent (required).

3 Select Critical if this job set is critical. A “critical” job is one that prevents the General 
Ledger (GL) post date from rolling forward, should the job fail.

4 Select Enabled to enable the job set.
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5 Complete the Batch Jobs block:

In the field: Do this:

Seq Enter batch job sequence number.
Note: Within a job set jobs are executed sequentially 
based on the seq number assigned.(required).

Job Type Select batch job request type (required).
Job Code Enter batch job request code (required).
Job Description Enter batch job description (required).
Threads View the number of threads used by the job (display 

only).
Commit Count Enter number of rows after which auto-commit is trig-

gered (required).
Errors Allowed Enter number of errors allowed (required).
Parent Select parent job (required).
Dependency Select type of dependency on the parent (required).

6 Select the Weekend box to perform batch jobs on weekend.

7 Select the Holiday box to perform batch jobs on a holidays. (Holidays are defined on the 
Job Holidays page.)

8 Select the Enabled box to enable the batch job.

9 In the Command field, enter command line for the job.

10 If you choose, use the RollbackSegment field to enter rollback segment for job.

11 Complete the Batch Jobs block:

In the field: Do this:

Thread Enter name of thread (required).
Trace Enter SQL trace level (0, 1, 4, 8, 12) The higher the num-

ber, the more activities Oracle Daybreak can trace 
(required).

12 Select Enabled box to enable the thread.

13 Save your entry.
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Setup tab (Job Holidays page)
Oracle Daybreak allows you to define holidays within the company on Job Holidays page. 
You can then use the Batch Jobs page to set up whether or not you want Oracle Daybreak 
to perform batch jobs on these days using with the Batch Jobs block Holiday box.

To define job holidays

1 On the Setup menu, choose Batch Jobs.

2 Choose the Job Holidays tab.

3 Complete the Job Holidays block:

In the field: Do this:

Holiday Dt Enter the date of the job holiday (required).
Description Enter the job holiday description (required).

4 Select Enabled to enable the holiday.

5 Save your entry.
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Monitor Batch Jobs tab (Match Batch Jobs page) 
Oracle Daybreak tracks the success of each batch process on the Monitor Batch Job page. 
If either a set of batch jobs or specific batch job should fail, you can resubmit it on this 
page and review the results in the Request Details block.

To use the Monitor Batch Job page

1 On the Setup menu, choose Batch Jobs, then choose the Monitor Batch Jobs tab.

-or-

Choose the Monitor menu, then choose System > Batch Jobs.

The Monitor Batch Jobs page is a display only page that contains the following blocks:

• Batch Job Sets
• Batch Jobs
• Batch Jobs Threads
• Request Details
• Request Results
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Batch Job Sets block
The Batch Job Sets block lists the batch job sets defined on the Batch Job page. The runt-
imes, the status, and frequencies appear for each job set. 

In this field: View this:

Set Code The code for batch job set.
Job Set Description The description for batch job set.
Status The job set status.
Freq Code The frequency at which the job set is to be executed.
Freq Value The value of the frequency code chosen for the job set.
Start Time The start time for the job set.
Last Run Dt The date of last run of the job set.
Next Run Dt The next run date for job set.
Enabled If selected, the job set is enabled.
Critical If selected, this job set is critical.
Parent The preceding job set.
Dependency The type of dependency on predecessor.

To resubmit a batch job set

Whenever a batch job set fails, it is best to resubmit it after correcting the errors that 
caused the failure. Errors can be viewed on this form’s Log Files page and in this page’s 
Monitor Page Jobs page Request Details block. Resubmitting a set causes Oracle Day-
break to re-perform the batch job set and dependent batch jobs. 

1 In the Batch Job Sets block, choose the batch job set to resubmit. (Only a batch job set 
with a status of FAILED can be resubmitted).

2 Choose Resubmit Job Set. 

Batch Jobs block
The Batch Jobs block lists the batch jobs within a job set. The status, threads, commit 
count, dependencies, enabled indicator and the holiday and weekend runtime indicators 
are shown for each job. 

In this field: View this:

Seq The batch job sequence number.
Job Type The batch job request type.
Job Code The batch job request code.
Status The job status.
Job Description The batch job description.
Threads The number of threads used by the job.
Commit Count The number of rows after which auto-commit is trig-

gered.
Errors Allowed The number of errors allowed.
Parent The preceding job.
Dependency The type of dependency on predecessor.
Weekend If selected, it batch job will execute job on weekend.
Holiday If selected, it batch job will execute job on a holiday.
Enabled The job enabled indicator.
Command The command line for the job.
Rollback Segment The rollback segment for job.
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To resubmit a batch job

Whenever a batch job fails, it is best to resubmit it after correcting the errors that caused 
the failure. Resubmitting a set will cause Oracle Daybreak to re-perform the batch job.

1 In the Batch Jobs block, choose the batch job to resubmit. (Only a batch job with a status 
of FAILED can be resubmitted).

2 Choose Resubmit Job Set. 

Batch Jobs Threads block
The Batch Job Threads block displays the status of the individual threads.

In this field: View this:

Thread The name of thread.
Status The status of thread.
Errors The number of errors in the thread.
Records The number of records in the thread.
Trace Level The SQL trace level (0, 1, 4, 8, 12).
Enabled The thread enabled indicator.

Request Details block
The Request Details block displays the status and the runtimes for each time the selected 
job ran.
 
In this field: View this:

Request Type The job request type.
Status The job request status.
Start Dt The job request is valid from this date and time.
End Dt The job request is valid till this date.
Run Start Dt The date and time on which the job run started.
Run End Dt The date and time at which the job run ended.
Description The job request description.
Process Dt The transaction is posted with this General Ledger effec-

tive date.

Request Results block
If a particular job requires that a result message be created, then that message appears in 
the Requests Results block. A message is usually created in the event of an error.

In this field: View this:

Request Result The result of the job request.
Description The result details.
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Monitor Jobs tab (Monitor Jobs page)
The Monitor Jobs page provides another view of monitoring all system processes, includ-
ing credit bureau requests and payment posting.   This page displays the data in reverse 
chronological order of the Run Start Date/Time, where as the Monitor Batch Jobs page 
provides the historical data about each job and job set.

To view the Monitor Job page

1 On the Setup menu, choose Batch Jobs, then choose the Monitor Jobs tab.
-or-
Choose the Monitor menu, then choose System > Jobs.

2 In the Job Type block, select the type of jobs you want to view in the Job Details block

If you select: Oracle Daybreak displays:

Batch Batch jobs (used primarily for the nightly processes).
Back Ground User submitted requests, such as reports and payment 

posting.
Credit Request Credit bureau requests.

3 In the View Last block, select the time frame of the contents of the Job Details block.

If you select: Oracle Daybreak displays:

1 Day All the types of jobs selected in the Jobs Type block of 
the last one-day.

2 Days All the types of jobs selected in the Jobs Type block of 
the last two days.

5 Days All the types of jobs selected in the Jobs Type block of 
the last five days.

All Days All the types of jobs selected in the Jobs Type block.

4 If you select View Failed in the Failed block, Oracle Daybreak displays the failed jobs on 
the type and time frame you have selected.
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5 In the Job Details block, view the following information about the jobs matching the con-
tents of the Job Type, View Last, and Failed boxes:

In this field: View this:

Request Type The job request type.
Status The job request status.
Job Set The job set code.
Job The job description.
Thread The job thread.
Errors The number of errors.
Records The number of records processed by the job.
Run Start Date/Time The job run start date time.
Run End Date/Time The job run end date time.
Description The job request description.
Process Dt The job process date.
Valid Execution Period The job start date/time.
Start Date/Time
End Date/Time The job end date time.

6 In the Job Details block, select the job you want to view in detail.

7 In the Job Results block, view the following details:

In this field: View this:

Request Result The result of job request.
Description The job request result details.
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Monitor Users tab (Monitor Users page)
The Monitor Users page allows you to view all users who have logged on to Oracle Day-
break, along with the log on time stamp and logout time stamp. The information appears in 
reverse chronological order of the log on time stamp.

To monitor users who have logged on to Oracle Daybreak

1 On the Setup menu, choose Batch Jobs, then choose the Monitor Users tab.
-or-
Choose the Monitor menu, then choose Users > Logins.

2 In the User Logins block, view the following information:

In this field: View this:

User Id The user id.
User Name The user name.
Login Date and Time The login date time for the user.
Logout Date and Time The logout date time for the user.

Hint: By pressing F7, entering a keyword to search on in either the User Id or User Name 
field, and pressing F8, you can search for and view the history of a particular user.
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Services tab (Services page)
The Services page allows you to track and maintain Oracle Daybreak’s processing ser-
vices, including credit bureaus, fax-in, and batch job scheduler. The system administrator 
can start or stop the service on this page by using the command buttons in the Action 
block.

To stop, start, or refresh a processing service

1 On the Setup menu, choose Batch Jobs, then choose the Services tab.
-or-
Choose the Monitor menu, then choose System > Services.

2 In the Services block, view the following information about Oracle Daybreak’s process-
ing services:

In this field: View this:

Service The service name.
Company The service company.
Branch The service branch.
Description The service description.
Status The service status.

3 In the Services block, select the processing service you want to work with and choose one 
of the following commands in the Action block.

If you choose: Oracle Daybreak:

Status Refreshes, or updates, the status of the service. The Ser-
vice page does not update the status in real time. You 
must choose Status after choosing Start or Stop to per-
form that command.

Start Starts the job service.
Stop Stops the job service.
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Log Files tab (Log Files page)
Various processes in Oracle Daybreak create reports in different log file with regards to 
what tasks they performed and what they encountered (for example, errors, failures, erro-
neous data, and so on.) The Log Files page lists and describes all such log files within Ora-
cle Daybreak. 

To view a log file

1 On the Setup menu, choose Batch Jobs, then choose the Log Files tab.
-or-
Choose the Monitor menu, then choose System > Log Files.

2 In the Log Files block, choose List Files.

3 View the following information in the Log Files block:

In this field: View this:

File Name The name of the file.
Type The type of the file.
Size The size of the file.
Time The time stamp of the file.

4 Use the Sort By block to arrange the contents in the Log Files block

If you select: Oracle Daybreak sorts the list by:

File name File name.
Time Time stamp.
Ascending Ascending order.
Descending Descending order.

5 In the Log Files block, select the file you want to view.

6 In the # of Lines field, enter the number of lines you want to view.

7 Select the Beginning or End button to indicate whether you want to see the lines from the 
beginning of the file or the end. 

8 Choose Show File.

The contents of the file appear in the File block.
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CHAPTER 9 : SUBVENTION FORM

The Subvention form allows you to set up lease subvention plans for producers (groups or 
individuals). Multiple producers may contribute to one subvention plan or a plan can be 
set for a specific producer. 

Subvention Types
Subvention can be offered in many forms for vehicle leases. The most common formats 
are the rent factor for vehicle leases. Rate/rent factor subvention involves sharing the 
finance charge (interest) by the participant (most frequently with the manufacturer). The 
finance company sets its buy rate (the minimum cost to the company to extend the loan to 
a customer). If the customer rate is less than this buy rate, then the amount equivalent to 
the interest amount for the difference (the buy rate minus the customer rate) is paid by the 
participant as the subvention amount.

Currently Oracle Daybreak supports the Lease subvention types - Rent factor, 
2 Residual
3 Deposit waiver
4 Cash bonus
5 Buy down

Subvention plans can be defined for one participant (for example, a manufacturer or a par-
ticular dealer) or group of participants (such as a dealer association). One subvention plan 
could have multiple sub plans and multiple participants could participate to each sub plan.

Subvention plan: 

• “Summer Special Event”

Subvention sub-plans for above plan: 

• 1.9% for 36 months
      - or -
• 2.99% for 48 months
      - or -
• 3.99% for 60 months
      - or -
• $1500.00 cash bonus 

Collection of subvention amounts can be set for each participant in the subvention plan 
with the Collection Method.

Oracle Daybreak supports following collection methods:

UPFRONT The entire subvention amount is collected at the booking 
of the loan from the producer proceed.

UPFRONT STATEMENT The entire subvention amount is collected at the time of 
the subvention statement.

PAY AS U GO The subvention amount is billed to the producer when the 
customer pays the loan payment. The producer is due for 
the amount at each statement.
Chapter 9 :-1  Setup Guide - Consumer Lease Collection



Subvention Refund
There are times when a loan is either paid-off early or gets charged off and the finance 
company refunds the unearned subvention amount back to the producer. The refund is 
available only when the subvention amount is collected from the producer proceeds 
(UPFRONT) or the whole amount is billed in the first statement (UPFRONT STATEMENT). 

You can set up Oracle Daybreak to allow refunds only for a certain period and not beyond 
that. The period can be set differently for charge offs and paid offs and can be based on 
two methods:

1 Days 
2 Term

Oracle Daybreak provides the following methods for refund amount calculation:

1 Earned 
2 Percentage

The earned method is used to refund the unearned portion of the collected subvention 
amount. The percentage method is used to refund a certain percentage of the subvention 
amount collected.

Lease Subvention page
The Lease Subvention Plans page allows you to set up subventions for leases.

To set up the Lease Subvention Plans page

1 On the Setup menu, choose Subvention, then choose Lease.
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2 On the Lease Subvention Plans page, enter the following information:

In this field: View this:

Plan Definition block:
Code Enter the subvention plan code (required).
Description Enter the subvention plan description (required)
Company Enter the company name (required).
Branch Enter the branch name (required).
Bill Cycle Select billing cycle (required).
Product Select the product (required).
State Select the state (required).
Asset Class Select the asset class (required).
Asset Type Select the asset type (required).
Sub Type Select asset sub type (required).
Asset Make Select asset make (required).
Asset Mode View the asset model (display only).
Age Enter the asset age (required).
Start Date Enter the start date for the subvention plan (required).
End Date Enter the end date for the subvention plan. (required).
Enabled If selected indicates the record is active.

Sub Plan Definition block:
Code Enter the subvention sub plan code. (required).
Description Enter the subvention sub plan description (required)
State Select the state (required).
Producer Group Select the producer group (required).
Producer Type Select the producer type (required).
Producer                Select the producer (required).
Grade                           Enter the grade (required).
Amount                     Enter the amount (required).
Term                           Enter the term (required).
Asset Type                Select the asset type (required).
Sub Type           Select asset sub type (required).
Asset Make                  Select asset make (required).
Asset Model                 View the asset model (display only)
Age                    Enter asset age (required).
Start Date                     Enter start date for the subvention plan (required).
End Date                   Enter the end date for the subvention plan (required).
Enabled If selected indicates the record is active.

Plan Details block:
Participant                    Select the participant (required).
Collection Method Select the collection method for the subvention plan 

(required).
Transaction Select the transaction code (required).
Rate Enter the subvention rate (required).
Override Select to allow overriding the rate at the time of under-

writing / funding (required).

Calculation block:
Method                  Select the subvention calculation method (required).
Max Spread Enter the max subvention spread value (required).
Factor Enter the subvention factor (required).
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Flat Amount Enter the flat amount (required).
Maximum Amount Enter the maximum subvention amount (required).
Max Spread Enter the max spread value (required).

Refund block:
Method (Paid off) Select the method if the account is paid-off early 

(required).
Basis (Paid off) Select the basis if the account is paid-off earl (required).
Days (Paid off) Enter the number of days in which the subvention can be 

refunded to the producer if the account is paid-off early 
(required). 

Term (Paid off)                         Enter the number of terms in which the subvention can be 
refunded to the producer (required).

Percent (Paid off)                 Enter the refund percentage if the account is charged-off 
                                                (required).
Method (Charge off) Select the method if the account is charged-off 

(required).
Basis (Charge off) Select the basis if the account is charged-off (required).
Days (Charge off) Enter the number of days in which the subvention can be 

refunded to the producer if the account is early paid-off 
(required).

Term (Charge off) Enter the number of terms in which the subvention will 
be refunded to the producer (required).

Percent (Charge off)             Enter the refund percentage if the account is charged-off 
(required).

Amortization block:
Balance Type                         Select the amortize balance type (required).
Method                                   Select the amortize method (required).
Frequency                              Select the amortize frequency (required).
Cost / Fee Method Select the cost / fee (required).
Enabled If selected indicates the record is active.
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CHAPTER 10 : CORRESPONDENCE FORM

The Oracle Daybreak system provides two types of correspondence: predefined and ad 
hoc. The following chart provides a quick summary of both:

This chapter explains how to set up ad hoc correspondence with the Correspondence form.

The Correspondence form is a cost-effective and easy to use way to build custom docu-
ments that draw information from the Oracle Daybreak database without additional pro-
gramming. You can choose what to include in a letter, create a template, and then use this 
template to produce a letter. 

The core of the Correspondence module is the document element -- the information stored 
in the database merged into the correspondence. Oracle Daybreak has document elements 
defined for commonly used data elements in correspondence, such as account numbers, 
account balances, customer addresses, telephone numbers, and due dates. 

Correspondence consists of a document file with text of your choice and the document ele-
ments from the Oracle Daybreak database.

You can create a correspondence set that consists of one or more documents. If a corre-
spondence set consists of more than one documents, such as the account details letter and 
a payment overdue letter, it prints both documents every time Oracle Daybreak generates 
correspondence for a customer. 

The Correspondence module creates the following standard ad hoc correspondence:

• Microsoft Word (RTF)
• Adobe Acrobat (PDF/XFDF)

Note: In this document and in the Oracle Daybreak system, the term BANKERS SYSTEM 
is synonymous with Adobe Acrobat.
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Setup master tab
On the Corresponding form, the Setup master tab branches to four tabs: Common and 
Lease. Which one of these four tabs you choose determines which product the correspon-
dence set up will affect.

• Choose Common to make changes to all correspondence regarding leases.
• Choose Lease to make changes to all correspondence regarding leases.

Functions tab (System Functions page)
The Correspondence form’s System Function page allows you to view the predefined 
functions for the lease product in Oracle Daybreak. These are attributes from the database.

Functions define how Oracle Daybreak retrieves data to include in correspondence. The 
data is retrieved as elements which are either specific database columns or calculated val-
ues. Elements are recorded on the Elements page.

To view the predefined functions

1 On the Setup menu, choose Correspondence.

2 Choose the Setup tab, then choose the product associated with the correspondence (Com-
mon or Lease).

3 Choose the Functions tab, then choose the System Functions sub tab.

4 In the Functions Definition block, view the following:

In this field: View this:

Name The function name.
Description The function description.
Function Type The function type.
Source Program The source program.

5 In the Functions Parameters block, view the following:
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In this field: View this:

Position                                           The parameter position.
Parameter The function parameter.
Description The function parameter description.

Elements tab (Elements page)
The Elements page displays the predefined document elements retrieved from the data-
base when Oracle Daybreak generates a correspondence.

In the Element Definitions block, only the Description field may be edited or updated.

To view the document elements

1 On the Setup menu, choose Correspondence.

2 Choose the Setup tab, then choose the product associated with the correspondence (Com-
mon or Lease).

3 Choose the Elements tab, then choose the Elements sub tab.

4 In the Element Definitions block, view the following information:

In this field: Do this:

Level0 Type The element Level0 type.
Name The element name.
Element The element type.
Description Enter the element description (required).
Data Type The element data type.
Source Function The element function.

5 Select the Enabled box to enable the element.

6 Save any changes you made to the entry.
Chapter 10 :-3  Setup Guide - Consumer Lease Collection



Elements tab (E-Forms Elements page)
The E-forms Elements page defines elements included when Oracle Daybreak generates 
online correspondence with a browser. The E-forms page is only set up for PDF elements 
using the XFDF format.These definitions translate the external element required by the 
vendor to a Oracle Daybreak correspondence element. 

Example
Vendor Element AllBorrowers.FullNameStreetCityStateZip

(Contains names of all borrowers with address of 
primary customer)

Oracle Daybreak Elements PRIM_APL_NAME
SPOUSE_APL_NAME 
PRIM_APA_ADDRESS1
PRIM_APA_ADDRESS2
PRIM_APA_ADDRESS3

Translation:
PRIM_APL_NAME || ', ' || SPOUSE_APL_NAME || ', ' || PRIM_APA_ADDRESS1 || '; ' 
||PRIM_APA_ADDRESS2 || '; ' || PRIM_APA_ADDRESS3

To set up the E-forms Elements page

1 On the Setup menu, choose Correspondence.

2 Choose the Setup tab, then choose the product associated with the correspondence (Com-
mon or Lease).

3 Choose the Elements tab, then choose the E-forms Elements sub tab.

4 In the E-form Element Definitions block, enter the following information:

In this field: View this:

Level0 Type Enter the element Level0 type (ACCOUNT) (required).
E-Form Source Enter the element e-form source. (Select ORACLE DAY-

BREAK for Microsoft Word correspondence or BANKER 
SYSTEMS INC. for XFDF format) (required).

Name Enter the element name (the name used in the external 
form) (required).

Description Enter the element description (required).
Data Type Select the element data type (DATE, NUMBER, or CHAR-

ACTER) (required).
Chapter 10 :-4  Setup Guide - Consumer Lease Collection



Translation Enter the translation for the e-form element (SQL state-
ment fragment defining the element data) (required).

5 Choose the Enabled block to enable the e-form element.

6 Save your entry.

Document tab (Documents page)
The Documents page allows you to set up the various documents and the data fields that 
Oracle Daybreak compiles together when creating a correspondence. Oracle Daybreak 
provides two different document formats: Word or XFDF: XML-based form. 

To set up documents to be compiled in correspondence

1 On the Setup menu, choose Correspondence.

2 Choose the Setup tab, then choose the product associated with the correspondence (Com-
mon or Lease).

3 Choose the Documents tab.

4 In the Document Definition block of the Documents page, enter the following informa-
tion:

In this field: View this:

Code Enter the document code to define the name for the new 
document (required).

Description Enter the document description for the new document. 
This entry appears in the Correspondence block on the 
Request page when you generate an ad hoc correspon-
dence (required).

File Name Enter the document file name for the resulting file (Word 
or XFDF document) (required).

Level0 Type Select the level0 type (ACCOUNT) (required).
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E-form Source Enter the element e-form source. (Select ORACLE DAY-
BREAK for Microsoft Word correspondence or BANKER 
SYSTEMS INC. for XFDF format) (required).

Product Select the document product (required).
Source Select the document source type (WORD DOCUMENT or 

XFDF: XML-BASED FORM DOCUMENT FORMAT) 
(required).

5 Select Enabled to enable the document definition.

6 Save your entry.

Document tab (Elements sub page)
The Elements sub page records the Oracle Daybreak account information that appears in 
the ad hoc correspondence.

To set up the elements compiled in correspondence

1 On the Setup menu, choose Correspondence.

2 Choose the Setup tab, then choose the product associated with the correspondence (Com-
mon or Lease).

3 Choose the Documents tab, then choose the Elements sub tab.

In the Document Elements block, enter the following information

In this field: View this:

Seq Enter the sequence number to order the document ele-
ments (required).

Type Select element type from the following (required):
S   System-defined. If you select S, the value is supplied 
by Oracle Daybreak and cannot be changed in the Corre-
spondence Request page.
C Constant.
UD User Defined Element. If you select UD, you can 
choose the value and change it in the Correspondence 
Request screen.
UC User Defined Constant. If you choose UC, you can 
choose the value, but you cannot change it in the Corre-
spondence Request screen.
T Translated Element. If a document contains an e-form 
element and you do not select T, the value will not be 
translated.

Element Name Select/Enter the element name (required).
Description Enter element description. Enter a description that is 

informative and easy to understand for the new element 
you create. (Check that the element name does not have 
blank spaces or special characters, such as the forward 
slash “/” or backward slash “\”.) Note: If the element is 
system-defined, Oracle Daybreak will automatically 
complete this field. (required).
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Data Type Select the element data type (required).
Format Mask Select the element format mask (required).
Default Value Enter the element default value (if appropriate).

4 If you want to include the element in the document, select Enabled.

5 Save your entry.

Document tab (Templates sub page)
The Templates sub page records the PDF template Oracle Daybreak will use to generate 
the ad hoc correspondence. You must update the Templates sub page every time you 
update the PDF template.

Note: The Templates sub page is only available for the XFDF: XML-BASED FORM DOCU-
MENT FORMAT.

To set up document template for XFDF correspondence

1 On the Setup menu, choose Correspondence.

2 Choose the Setup tab, then choose the product associated with the correspondence (Com-
mon or Lease).

3 Choose the Documents tab, then choose the Templates sub tab.

In the Document Elements block, enter the following information

In this field: View this:

Filename Enter the template file name as it appears in the 
/DOC_TEMPLATES. Make sure to include the .pdf exten-
sion (required).

Product Select the product type this template is valid for 
(required).

Customer St Select the applicant/customer state this template is valid 
for (required).

Producer St Select the producer state this template is valid for 
(required).

App/Acc St Select the account state this template is valid for 
(required).

New Template If selected, indicates that the document template is new.
Loaded If selected, indicates that the document template is 

loaded.
Enabled If selected, indicates that the document template is 

enabled.

4 On the Documents page, choose Load Template 

5 Save your entry.

6 Press F8 to refresh the current page.

On the Templates sub page, the Loaded and Enabled boxes are selected for the pdf file you 
entered in the Filename field.
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Correspondence tab (Correspondence page)
The Correspondence page allows you to define who will receive the documents you cre-
ated on the Documents page by creating correspondence sets. Each document must belong 
to a set, and a set can have more than one document.

To set up a correspondence set

1 On the Setup menu, choose Correspondence.

2 Choose the Setup tab, then choose the Lease product associated with the correspondence.

3 Choose the Correspondence tab, then choose the Correspondence sub tab.

4 In the Correspondence block, enter the following information:

In this field: Do this:

Code Enter the correspondence code (required).
Description Enter the correspondence description (required).
Print Schedule Enter the correspondence output schedule type 

(required).
Level Enter the correspondence level0 type (required).
Group Select correspondence group (required).

Note: The correspondence group is maintained through 
the Correspondence transaction code setup as shown 
below.

Company Select the correspondence company (required).
Branch View the correspondence branch (display only).
Product Select the correspondence product (required).

5 Select the Enabled block to enable the correspondence.

6 In the Documents block, enter the following information:

In this field: Do this:

Document Select the correspondence document (required).
Recipients Select the recipients for the document (required).
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7 Select the Include box to include the recipient selected.

8 In the Functions block, enter the following information to define the functions that should 
be executed before or after correspondence is generated. (Note: Creating custom functions 
requires programming at set up.)

In this field: Do this:

Function Select the correspondence functions (required).
Exe When? Select when to execute the correspondence function 

(required).

9 Save your entry.
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CHAPTER 11 : ACCOUNT DOCUMENT TRACKING FORM

The Account Document Tracking form allows you to view documents that have been 
attached to an account in the form of GIF files, PDF files, DOC files, XLS files, and TXT 
files. Any documents that were attached to the account when it was still an application, 
such the application received as a fax and saved as a GIF file, appear on the Account Doc-
ument Tracking form.

Set Up
Documents of the following format can be attached to an account:

• GIF
• PDF
• DOC
• XKL
• TXT

To attach an document to an account

1 Save the document you want to attach to an account with the following format:

<ACCOUNT_NBR>.<DOCUMENT TYPE CD>.<DOCUMENT SUB TYPE CD>.<PAGE 
NUMBER>.<FILETYPE> 

The delimiter between account number, document type, sub type and page number is “.”. 
File extension tells the file type.

Example: 20001000010483.APP.APP_IMG_PAGE.1.GIF
     20001000010483.CON.CON_DOC.1.PDF

2 Save the document to attach in the following file: 

$CMN_SERVER_HOME/acct_doc_load/

-or-

$CMN_SERVER_HOME\acct_doc_load

3 The batch job set code SET_DOT reads the directory for new files to be loaded in the data-
base. It inserts records in account documents and documents details table and will move 
the file to the directory specified in the system parameter DOT_STORAGE_DIRECTORY.
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Lookup types
The Account Document Tracking form uses the following look up types:

DOCUMENT_FILE_TYPE_CD
DOCUMENT_SUB_FILE_TYPE_CD
DOCUMENT_TYPE_CD

Note: Many parameter values are restricted based on system lookups. For more informa-
tion, see the Lookup page section in the Administration chapter.

Please refer to the Excel file Appendix_Lookups for further definitions and functions of 
individual parameters.
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